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Preface

When we saw the original Macintosh in 1984, we knew that this was
the first real multimedia computer....and so, in 1985 we introduced
our first multimedia application, VideoWorks. Boy, have we and the
Macintosh come a long way! With the Macintosh II, Apple extended
the definition of what a multimedia computer should be. In 1989, we
introduced our next generation multimedia application, MacroMind
Director Release 1.0.
With the combination of stereo sound, high resolution color
graphics, WYSIWYG user interface, and the computing power of the
Motorola 68030 processors, the Macintosh II represents the best
platform available today for multimedia creation and interaction.
While continuing to support the black and white Macintosh Classic
and SE, MacroMind has been working on taking advantage of the
Mac H's special capabilities over the past several years. We used our
original product, VideoWorks II, as a starting point to develop a
product that brings to you the ease of use necessary to handle the
infinite possibilities that multimedia offers. MacroMind Director
Release 3.0 is the result of our efforts.
We call our product MacroMind Director because it is designed to
put the power of a multimedia production department on your
desktop. Much like a film, television or theater director instructs the
cameraman, lighting woman, sound guy, actors, scenery builders,
etc., you can now control the production of a multimedia experience
yourself. This is what good software is all about: simplifying and
automating the process of creation, while at the same time making it
more cost effective and time efficient.
MacroMind Director is designed to help you tap the multimedia
capabilities inherent in the hardware and system software of the
Macintosh. I t  enables you to find real solutions to problems and
challenges in your work and life. MacroMind Director is used by a
variety of our customers to help them articulate and communicate
their ideas and concepts in ways that are not possible with other



communication media. Of the main uses for MacroMind Director,
three key areas stand out: multimedia presentations, desktop video
production, and visualization.
Multimedia Presentation is a term that describes the usage of a
personal computer to produce high quality animated color graphics
with sound tracks for presentations, sales reports, and proposals, as
well as interactive kiosks, point of purchase displays, or museum
exhibits. Multimedia presentations can be seen on a Macintosh
monitor, a large display screen, or video projector. This means they
can take advantage of the interactive capabilities of a computer.
Multimedia presentations bring the pizza77 of Hollywood to the
boardroom or sales conference, allowing you to improve the
effectiveness of your message compared with more traditional
methods such as slide shows or overheads. Exciting presentations
with animated titles or bullet charts, synchronized music, sound
effects, and even voice-over sound tracks are all possible with
MacroMind Director. I f  your presentation or report really matters,
you'll want to make it one presentation that they'll never forget!
Desktop Video Production is in many ways similar to multimedia
presentation, except that the end result is seen on film or videotape,
rather than displayed interactively on a computer screen.
MacroMind Director has the features necessary to create desktop
videos for in-house or industrial video production, or for cable,
educational, or artistic television. Animated storyboards (called
animatics) have already been created by major film, advertising, and
television production companies with MacroMind Director. Some
broadcast television shows have even used MacroMind Director for
on-screen graphics. MacroMind Director helps producers, directors,
writers and many others to communicate their creative ideas in a
cost effective, time efficient way.
Visualization is a term we use to refer to simulations, prototypes,
conceptual diagrams, and other animated phenomena that are
created with computers for research, design, or education.
Combined with the Macintosh's great graphics and sound
capabilities, MacroMind Director is the perfect tool to use to create
scientific, engineering or educational visualizations. In fact,
visualization does not refer to only animated graphics, but sound
effects, real-time interaction, and 3D graphics as well. Until the
Macintosh, visualization capabilities existed only on expensive
mainframes and workstations. Now you can graph your data,

vi P r e f a c e



import it to MacroMind Director and animate a sequence of images
so you can further understand and communicate the meaning of
your data. As time goes on, visualization will be one of the most
important benefits that computers bring to society at large.
We had two design goals when we set out to develop MacroMind
Director; first, to develop a rich and powerful multimedia
production tool, and second, to implement the features to make it
easy to learn and use. We wanted you to be able to implement great
ideas, see concepts you never dreamed of being able to see, witness
phenomena that only theoreticians extrapolate on. MacroMind
Director is a powerful, easy to use product, with the features and
capabilities necessary to help you create animation and multimedia
presentations simply and quickly.
We started off developing many ways to automate the production of
animations and special effects. Auto Animate is one such feature
allowing you to create animated titles in a snap. Studio features
such as Auto Transform and Cast to Time help you rotate or skew
images and automatically turn them into moving sequences. Space to
Time and other features like In-Between and transitions (found in the
Studio Score window, a time-line notational spreadsheet) enable you
to create sophisticated animations and effects easier than ever before.
MacroMind Director lets you bring automatic animation creation
capabilities together with powerful tools to create sophisticated
artwork and text. MacroMind Director contains a full-featured color
paint program that is competitive with other high-end paint
programs for the Macintosh.
Additionally, MacroMind Director can import virtually anything
that the Macintosh has to offer. Graphics programs, 3D drafting and
modeling, drawing, and painting programs - we can deal with them
all. Got some color PICT with a crazy palette? How about a sound
you just digitized? Or maybe you're tired of copying each graphic
from a Scrapbook and pasting it to the Cast. Well, all of these data
types-PICTs, Sounds, Scrapbooks, MacPaint files, and PICS files, can
be imported directly to MacroMind Director with a click of the
mouse.
In keeping with the MacroMind tradition, we've strived to make
sure that MacroMind Director represents the state-of-the-art in
Macintosh graphics software, ready for the new crop of advanced
graphics cards. MacroMind Director is compatible with color
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scanners, digitizers, NTSC video output devices, genlocking,
accelerator cards, 16 bit audio cards, color printers, slide creators (is
there anything else we've missed?).
To help you spark your imagination and get you started you'll find
lots of great examples of color and B&W animation, artwork, and
sounds, as well as a series of tutorials that take you through most of
the basic features of MacroMind Director. As usual we've included
an interactive Guided Tour disk to further help you through the
basics of MacroMind Director.
And should you ever wish to find out more about the rich features of
MacroMind Director while using it, the program includes an on-line
help capability we call Object Sensitive H e l p .  A t  a click of your
mouse, you can get a description of any feature within MacroMind
Director. Just hold down the Shift-Option keys and click anything
you want to find out about. We obviously can't mention every new
feature here, but we hope you'll spend the time investigating and
browsing through the program and the manuals to learn about all of
the great features we have included in MacroMind Director.
So thanks a lot for buying our product and I wish you many happy
hours of creativity, learning, and visualization!

Marc Aaron Canter
Founder of MacroMind
June, 1991
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Introduction to MacroMind Director

Welcome to the world of personal multimedia.
MacroMind®DirectorTm puts more graphics, sound, and
animation power into your hands than ever before. We
are all very proud of this product. We sincerely wish you
hours, days, and weeks of professional and creative
fulfillment from using MacroMind Director.
Welcome to a whole new way to use your Macintosh®.
Instead of just looking at a chart or document on the
screen, you can create moving presentations with movies,
slide shows, and clip animation that really bring your
Macintosh to life.
You can start out at the simplest level, creating a slide
show with automatically animated titles, and work up to
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creating elaborate, detailed movies with sound. Animated
presentations, multimedia storyboards, and educational movies are
all possible, and well within the capabilities of MacroMind Director.
Welcome also to a partnership with MacroMind. We are committed to
providing great products that spark your creativity. We also offer other
products that work with MacroMind Director, such as MediaMaker-
and Three-D, and utilities for accelerating Director movies or playing
them in HyperCard®.
We welcome your comments and suggestions. And we particularly
welcome samples of the work you are doing.

About MacroMind Director
MacroMind Director turns your Macintosh computer into a
multimedia studio fully capable of producing sophisticated
animated effects. High-quality color graphics plus complete sound
and animation control allow you to create compelling presentations,
displays, and training programs.
MacroMind Director makes it possible for you to do things you
either could never do before, or could do only with hundreds of
thousands of dollars worth of equipment. You can quickly and
effectively animate bullet charts, titles, and bar graphs. You can
create presentations with clip art images you already own. You can
combine graphics, digitized photographs, text, and animation into
one presentation synchronized with sound effects. You can use
animation for impact, clarity, and effectiveness in training,
education, interactive video, and multimedia presentations. You can
create a full-fledged animated movie (or group of movies) with
complete control over every aspect of the presentation.
MacroMind Director has two major parts, Overview and Studio.
Overview controls the sequence and timing of an entire presentation.
You use Overview to create a document that includes MacPaint®
files, and other documents, including MacroMind Director movies.
You can use it to create sophisticated, multimedia slide shows with
animation, sound, and visual effects.
Studio allows you to create multimedia productions. You can use
the full-featured color and black and white Paint window to draw
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the images you want to use, or you can import images from other
programs, with scanners, and other hardware. Studio provides
many automatic features to help you create animations, so you don't
have to draw every frame individually. You have complete control
over the images, their sequence, their relationship on the screen,
their sound effects—everything you need to create detailed and
effective animated presentations.
Studio includes a HyperTalk®-like language called Lingo- that lets
you control animation, text, color, and palettes with scripts. Lingo
scripts allow you to make any multimedia scene interactive, to any
degree of detail or design. Because Lingo's syntax resembles
HyperTalk, users familiar with HyperTalk should feel comfortable
authoring in Director. The MacroMind Director Interactivity Manual
describes how to create Lingo scripts to add interactivity to your
presentations.
Two features of MacroMind Director, Auto Animate and transitions,
span both Overview and Studio. Auto Animate gives you quick
access to several animated text effects. You can create special titles,
bullet charts, bar charts, and rolling credits, simply by typing the text
and making choices for style, tempo, color, and other settings.
Transitions offer you built-in ways of moving from one image to
another: dissolves, wipes, reveals, and pushes. You can use Auto
Animate and transitions in either the Overview or the Studio portion
of the program.

About this Manual
You are reading the MacroMind Director Overview Manual now. This
manual provides a complete introduction to Overview, showing you
how to create, manage, and control presentations. This manual
begins with a series of tutorials that take you step-by-step through
the basic skills you need to use Overview. This manual also contains
a user guide and reference for all the Overview features in
MacroMind Director.
Chapter 5, "Using Overview," is organized by task. Each task is
explained in detailed, step-by-step fashion. I t  is an important
resource for those of you who learn through experimentation. I f  you
suddenly realise that you want to do something specific (like,
adding sounds), you can look up how to do it in this chapter.
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Chapter 6, "Overview Reference," is organized by menu command
and window. Use this chapter to learn about specific commands and
features in the Overview.
If you are a new MacroMind Director user, begin by working
through the tutorials in this book. After going through the tutorials,
feel free to experiment with Overview to create your own
presentations. You can then move on to the MacroMind Director
Studio Manual, which teaches you how to create animated movies
using the Studio.

Using the Tutorials
The tutorials at the beginning of this manual have been carefully
designed to introduce you to practical skills and to give you an
understanding of how and when to apply them.
The tutorials use the following format:

This is a procedure
1. Instructions for steps are printed in this format.
Explanations and other comments are printed in the standard
typeface.
The tutorials are designed to be followed in order, from beginning to
end. Follow the directions exactly, referring to the illustrations to be
sure you haven't skipped any steps.

Getting Help
MacroMind Director contains an Object Sensitive Help system that
you can use whenever you have a question about a menu command,
dialog box, window, tool, or control.
There are two ways to use MacroMind Director Help:
1. Choose  Help from the Apple menu.
Choosing Help from the Apple menu displays the first screen of the
Help system. You can move through the information screen by
screen. Choose the category of help you want using the pop-up
menu at the bottom left corner of the window.
2. Press Option-Shift and click the item you want information about.
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When you press the Option and Shift keys at the same time, the
pointer changes to a question mark. You can then use the question
mark pointer to choose the menu command or click the item you
want help with. The Help window appears with the appropriate
screen displayed. I f  you have an extended keyboard, pressing the
Help key also displays the Help system.
If you are running under System 7.0, you can also use Balloon help
to get help on MacroMind Director.
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Chapter 1: Getting Started

101

T h i s  chapter shows you how to start the MacroMind
Director program, and how to run the Guided Tour and
animation examples. The examples include several "clip
animation" files, animated movies of single objects that
you can use in your own presentations. Also included
are sounds and color palettes you can use as well.
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Starting MacroMind Director
If you have not yet installed MacroMind Director on your hard disk,
refer to the instructions in the Getting Started manual for installation
information. You must install the program on your hard disk before
you can use it.
To start MacroMind Director,
1. L o c a t e  the MMDirector 3.0 folder on your hard disk and open it.
When you installed MacroMind Director, you placed the Director
application in a folder you created called MMDirector 3.0.
2. Double-click the MacroMind Director application icon.
This starts MacroMind Director. I f  this is the first time the program
has been started, a dialog box appears for you to type in your name,
organization, and the program's serial number.
3. Ty p e  your name, press the Tab key, then type the name of your

organization.
4. Press the Tab key, then type the program's serial number.
Look for the serial number on the registration card included in your
MacroMind Director package, on the License Agreement envelope,
on the original Program disk label, or on the bottom of the Director
slip case box.
Be sure to check the screen carefully to make sure the information is
correct. Your name, organization, and serial number wi l l  appear on
the MacroMind Director title screen exactly as you enter it here.
Once you click Done, there is no way to change this information.
5. W h e n  you are sure your name, organization, and serial number are

correct, click Done.
MacroMind Director starts and displays the title screen.
MacroMind Director consists of two parts - Overview and Studio.
The first time MacroMind Director starts, it displays the Overview
window. Subsequently, the program starts in whichever part of the
program you were last using. To move between Overview and
Studio, choose To Studio or To Overview from the File menu.

8 S t a r t i n g  MacroMind Director



Opening an
Overview document

Taking a Tour of MacroMind Director
The MacroMind Director Guided Tour gives you a good perspective
of the program. I t  shows you a general picture of what it contains
and how the parts are related.
The Guided Tour is a simulation of the real MacroMind Director
program that was itself created with MacroMind Director. I t  offers
you the chance to work with the program guided by an organized
presentation. You can select the portions of the program you want
to see, and you can stop at any time.
To run the Guided Tour,
1. S t a r t  your Macintosh.
2. Loca te  the Guided Tour folder inside the MMDirector 3.0 folder on

your hard disk
3. Double-click the Guided Tour folder to open it.
4. Double-click the Main Menu icon.
The Guided Tour movie opens.
5. H o l d  down the Shift key while you click Play in the Control Panel to

start the Guided Tour.
The Guided Tour displays its first screen. Following the instructions
on the screen, you can move through as much of the Guided Tour as
you like. To stop at any time, press Command-W.

Playing MacroMind Director Presentations
You use MacroMind Director to create multimedia presentations.
But you also use the program to play them as well. This section
shows you how to play MacroMind Director presentations, and
you'll get to see examples of what the program can do.

Your MacroMind Director package includes examples for both black
and white and color Macintosh systems. SlOpOirli
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Before you begin I f  you are working with a color Macintosh, set the
monitor to "Black & White/Grays," 2 Colors, in the Control Panel.
1. S t a r t  MacroMind Director.
MacroMind Director starts.
2. Choose  Open from the File menu.
MacroMind Director displays a directory dialog box.
3. Loca te  the B&W Examples folder inside the MMDirector 3.0 folder on

your hard disk.
4. Double-click the B&W Examples folder to open it.
5. O p e n  B&W Movie Show.
MacroMind Director displays the Overview window.
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Fig. 1.1 The B&W Movie Show Overview window
The Overview, Panel, and Stage windows make up the Overview
portion of MacroMind Director. You use the Panel to control the
presentation. The presentation appears on the Stage. The icons in
the working area of the Overview window represent the different
documents and effects used in B&W Movie Show. You will learn how
to create presentations using the Overview window in the next
chapter.
To get a good view of the Stage, you simply close the Overview
window.
6. C l i c k  the close box of the Overview window.
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Playing the B&W
Movie Show
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Controlling the
presentation

The Overview window disappears, leaving the Panel window open
on the Stage.
1m* Tips & Hints The Stage window size is set by choosing Preferences
from the Control menu. I f  the Stage window seems too big or too
small, you may need to adjust it. See Preferences in The Control Menu
of Chapter 6: Studio Reference in the MacroMind Director Studio Manual.

The control buttons on the Panel window work like the buttons on a
VCR. You can play, stop, step, and rewind the presentation. You
can also use the Loop button to make the presentation play
continuously.

Fig. 1.2 The Panel

To play the Movie Show,
1. C l i c k  Play in the Panel.
MacroMind Director plays the B&W Movie Show, which contains
several different presentations. When the Movie Show reaches the
end, it starts over again by looping back to the beginning.
Note I t  is remotely possible that MacroMind Director will be unable
to find a document it needs. In such a case, an alert dialog box
appears. For information, see Appendix A: Finding Missing
Documents.
When you are ready to stop the presentation,
2. C l i c k  Stop in the Panel.
The presentation stops, wherever it happens to be. In the next
section you will see how to control the presentation in different
ways.

In some types of presentation, you need to do more than play the
presentation through. Or you may need to move through your

SIDPO4n1 •
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presentation step by step. You might need to go back occasionally to
review a previous screen or sequence.
The following steps demonstrate these ways of controlling the
presentation.
1. C l i c k  Rewind in the Panel.
MacroMind Director rewinds the presentation to the beginning.
2. C l i c k  Step in the Panel.
The presentation plays the next movie. When the movie finishes, the
presentation pauses. You can move through the whole sequence one
step at a time with the Step button. You can also click Step while a
movie is playing to go immediately to the next movie.
3. C l i c k  Back in the Panel.
The previous movie begins to play. You can back up as far as you
want with the Back button.

Control
11 Rewind
11 Back Step : • :0
■  Stop

Step
▶ Play

F

✓,s�� Sound Is On
Preferences...

The Control Menu

Using the Stage

So far you have used the Panel window to control the presentation.
You may wish to close the Panel window, so that more of your
presentation is visible on the screen. MacroMind Director provides
the Control menu as an alternative to the Panel window. I t  contains
the same control commands, except for Loop.
You use the Window menu to open and close the Overview and
Panel windows, and to bring the Stage to the front or place it behind
the other windows.
4. Choose  Panel from the Window menu.
MacroMind Director closes the Panel window, leaving the Stage as
the only open window.

The Stage is a unique window that can take over the entire screen,
including the menu bar at the top. This makes it possible to display
a presentation without anything else visible.
To display the Stage alone,
1. Choose  Stage from the Window menu.
If you are working on a 9-inch monitor, the Stage window takes over
the whole screen. Now when you play the presentation, nothing else
shows.
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Shortcuts

You may be wondering how to play the presentation without either
the Panel or the Control menu. Have no fear: the menus are still
available, even though you can't see them. You can pull them down
and choose menu commands in the usual way.
Note I f  you are working on a larger monitor, the Stage will appear
in the middle of your screen and you will still be able to see the
menu bar on top of the screen.
2. Choose  Play from the Control menu.
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Fig. 1.3 1.3 Choosing from a hidden menu
When you want to stop the presentation,
3. Choose  Stop from the Control menu.
4. Choose  Rewind from the Control menu.

MacroMind Director provides several useful shortcuts so that you
can control the presentation without the use of either the Panel or the
Control menu.
To advance the presentation one step with the mouse,
1. C l i c k  anywhere in the Stage.

siopoini
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This is the same as using the Step command.
Additional shortcuts use the Command key. For example, to play
the presentation from the keyboard,
2. H o l d  down the Command key and press A.
The B&W Movie Show starts where it had stopped and continues.
Subsequent directions with the Command key will be given as
"Press Command-A."
You can also control your presentation with the numeric keypad.
For a complete list of shortcuts, see Appendix B: Command Keys and
Shortcuts at the end of this book.
To stop the presentation,
3. Press Command-W.
Finally, to go directly to the Stage and start the presentation,
4. Press the Shift key while you click Play in the Panel.
The Stage takes over the screen, and B&W Movie Show plays.
5. Press Command-W.
The hidden windows return to the screen.

It  F i l e  E d i t  C o n t r o l  W i n d o w  S o u n d

REW BACK STEP
1111.

PLAY LOOP
•

B&W Mouie Show Oueruiew

• r —I•
2..

c .

— b .
0 00
0

1-1

:. E C  .: :  3 0 3  . :  \ W s  :eteet.a. e a m m .•Iir 'II •1 i
O'Neill DemoSan FranciscoStellar Skier

Fig. 1.4 C o m m a n d -W returns the Overv iew and  Panel windows to the screen
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Playing the Color
Movie Show

Summary

01* Tips & Hints You will use these controls when you are creating
presentations as well. The tutorials in the next chapters provide
step-by-step instructions.

If you have a color monitor and at least 2 megabytes of memory,
after the B&W Movie Show has finished running you can run the
example color movie show.
Before you begin Set the monitor to "Color," 256 Colors, using the
Control Panel desk accessory.
If your monitor can display only 16 colors, set the color resolution to
16, and go ahead with the example. Be aware, however, that the
color quality or display speed will be affected, since the example is
designed to work with a 256-color monitor.
1. Loca te  the Color Examples folder on your hard disk.
The Color Movie Show is in the Color Examples folder.
2. O p e n  the Color Movie Show and play it.
MacroMind Director plays the sample color presentation.

In this first chapter you have started the MacroMind Director
program, and played the example movies.
You have seen the Guided Tour, and so you have an idea of how the
program works.
You have used the controls in the Panel to play, stop, rewind, step
and back step through presentations. You will use these controls
everywhere in MacroMind Director not only to play finished
presentations, but also while creating the presentations themselves.

SIDIJOIN

Chapter 1: Getting Started 1 5



16 P l a y i n g  MacroMind Director Presentations



;71

Chapter 2: Auto Animate Tutorial

T h i s  tutorial continues your introduction to the
Overview portion of MacroMind Director, concentrating
on Auto Animate. The Overview window is where you
put together presentations.
Auto Animate is the feature that lets you create special
animated effects for charts and text. I t  lets you
automatically create effects such as animated bar charts,
bullet charts, and text that zooms in or out. You can use
Auto Animate effects alone or in combination with
background images.
In this tutorial you will get a basic idea of how to work
with the Overview window—dragging icons, arranging
images in the foreground and background, and so on.

SIOPO4n1 U N.)

17



Later tutorials show you how to use graphic images in a timed
sequence, how to add special effects like sound and transitions, and
how to incorporate animated graphics with other images.
The tutorials build on each other, so unless you've used an earlier
version of MacroMind Director, you're better off starting at the
beginning and working your way through the tutorials in order.

Starting Up
Before you begin I f  you are working with a color Macintosh, set the
monitor to "Black & White/Grays," 2 Colors, in the Control Panel.
If you haven't started the program already, do so now.
1. S t a r t  MacroMind Director.
MacroMind Director starts up.
MacroMind Director displays the Overview, Panel, and Stage
windows. I f  you do not see the Overview window, the last person to
use it was working on the Studio side of the program.
To get to Overview,
2. Choose  To Overview from the File menu.
If you have just completed the previous tutorial and are in
Overview, you can simply open a new Overview document.
3. Choose  New from the File menu.
MacroMind Director displays an empty Overview window.
As you remember from Chapter 1, the Panel, Overview, and Stage
windows make up the Overview portion of MacroMind Director.
Presentations you create are shown on the Stage. You can move and
close the other windows to take advantage of the full size of your
monitor. You control the presentations with the Panel, with
commands on the Control menu, or by using shortcuts.
The Untitled Overview window contains a new Overview
document. After you create your presentation, you will save it and
give it a filename. The icons in the icon bar represent the different
kinds of documents and effects you can use in your presentation.
The working area is presently empty; soon you will drag icons into
this area to create your presentation.
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Fig. 2.1 Icons represent document types and effects

You work with the Overview window by dragging document and
effects icons into the working area. They are automatically linked
together into a sequence. When you play the presentation, they are
activated in order, from left to right. You will see how this works in
the following tutorials.

Creating an Animated Bullet Chart
Suppose you are the director of marketing for a national greeting
card company. You are going to propose a new line of greeting
cards, based on new holidays. You have just purchased MacroMind
Director and want to enhance your presentation with animation.
You are presenting three alternatives to your fellow executives. You
plan to emphasize a greeting card line based-on new holidays, but
you will discuss two other alternatives first—a sentimental or
romantic line and a humorous line. You will create a bullet chart for
convenient reference during the first part of your presentation. SI0904% U n)
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Using Auto Animate
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You use Auto Animate to create a quick bullet chart.
1. D r a g  the Auto Animate icon into the working area of the Overview

window.

Fig. 2.2 Dragging the Auto Animate icon into the working area

MacroMind Director displays the Auto Animate dialog box. Here
you indicate which of the Auto Animate features you want to work
with. Your choices include a bullet chart, a bar chart, zooming titles,
banners, credits, and special text effects.
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Fig. 2.3 The Auto Animate dialog box

Each Auto Animate choice lets you animate text and numbers in a
different way. In this tutorial you will use the first two choices.
2. S i n c e  the Bullet Chart choice is already selected, simply click OK.
MacroMind Director displays the Bullet Chart dialog box.
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 B u l l e t  Chart
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Title:
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i t le

First Bullet TeHt
Second Bullet TeHt

❑  Animate Title
❑  Mouseclick Advances [ Preview... Cancel OK

Fig. 2 .4  The Bullet Chart  d ia log box

The Bullet Chart dialog box gives you complete control over the
contents and style of your animated bullet chart. In general, you
type the text into the boxes at the top of the dialog box, then change
the text style, motion, and bullet type to suit the chart you are
making.
The title of your bullet chart is "New Markets." The Title box is
already selected, ready for you to type your own title.
3. Ty p e  "New Markets."
4. Press  Tab to move to the first bullet text box.
Using the Tab key to move to the next text box selects the entire
entry. This makes it easy to type in the text you want.
The bullets you are presenting are "Sentimental/Romantic,"
"Humorous," and "New Holidays."
5. E n t e r  these words and phrases into the first three boxes for bullet

text.
Use the Tab key after you type the text to move to the next text box.
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Previewing the
bullet chart

Animating the title

Try it out!
1. C l i c k  Preview at the bottom of the dialog box.
MacroMind Director displays the preview screen, showing the bullet
chart as it will look during your presentation.
2. C l i c k  Play in the Preview window to see the bullet chart in action

again.

lit F i l e  Ed i t  Control Window Sound

New Markets

•  Sentimental/Romantic

•  Humorous

•  New Holidays

 B u l l e t  Chart Preview

Play ( Center ( Cancel OK

Fig. 2.5 Your first bullet chart

3. C l i c k  OK to return to the Bullet Chart dialog box.
That's all there is to it! You have made a basic bullet chart simply by
entering the text you want. MacroMind Director does the rest.
(Which is why this feature is called Auto Animate—the animation is
automatic.)

The bullet chart you have just created animates only the bulleted text
and the bullets themselves. Suppose you also want the title to fly in.

SIDp04r11
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To animate the title,
1. C l i c k  the Animate Title check box.
Now the bullet chart title will fly into place before the bulleted text
and bullets.
2. C l i c k  Preview to view your modified bullet chart.
You can make changes and preview them over and over again, until
your chart is exactly as you want it.
3. C l i c k  OK to return to the Bullet Chart dialog box.

Changes you can
make

You can experiment by changing the text, motion, and bullet type so
that your bullet chart suits your taste. You will return to this dialog
box in a later stage of this tutorial to adjust the timing and spacing of
your bullet chart so that it fits into a special frame, and so that it
works together with your planned speech. As you try out the
various choices, remember that you can see the results by clicking
Preview.
You can click the Title and Bullet text style buttons to change the
font, style, and size of the text. MacroMind Director allows you to
use any font you have on your System, and it presents the same style
choices you are used to from other Macintosh applications.
You can choose from pop-up menus to change the Motion and Bullet
type. The "Motion" choices let you determine where the text comes
from as it moves into its position. The "Bullet Type" is the actual
symbol used to mark each item. MacroMind Director offers several
choices for each feature.
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Fig. 2.6 Choices for Motion and Bullet type

After you have finished experimenting, you should return to the
Overview window.
1. C l i c k  OK to return to the Overview window.
MacroMind Director has placed a Bullet Chart icon in the first
position in the working area. The information about the bullet chart
is stored in the icon. A l l  of the choices you made in the Bullet Chart
dialog box are remembered in that icon. You can double-click the
icon to return to the Bullet Chart dialog box at any time to make
modifications.
You have just created a slide. A  slide is one element of a
presentation. You can create additional slides to the right of this first
one. You can have many, many slides in your presentation. They
will be played in order, moving from left to right. I t  is like having an
animated slide show.
An Overview presentation is often called a "slide show" because it
consists of a sequence of slides.
The slides you create can include sounds, movies you create in the
Studio portion of MacroMind Director, and graphic elements from
other programs. You can use the Overview window to create special
transitions from one slide to another. And you can set the time you
want each slide to display.
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In the following section, you will modify the slide you have just
created by adding a background element to the bullet chart.
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Adding a Graphic Background
Your work in greeting cards has given you plenty of experience in
decorative borders. You decide to add a border to your bullet chart.

Using a document
from disk

You will use a MacPaint document for the border.
1. D r a g  the MacPaint icon into the working area.

Fig. 2.7 Dragging the MacPaint icon into the working area
MacroMind Director displays a directory dialog box. You use this
dialog box to open the MacPaint document you want. The Tutorials
folder supplied with your MacroMind Director program includes the
MacPaint document for your border.
2. L o c a t e  the Overview Tutorials folder inside the Tutorials folder on

your hard disk.
3. O p e n  the Overview Tutorials folder and locate the Auto Animate

Tutorial folder.
The document you want is in the folder called Auto Animate Tutorial.
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Making a
compound slide

4. O p e n  the Auto Animate Tutorial folder, then open the document
titled Card Border.

MacroMind Director displays a MacPaint icon in the second slide
position in the Overview window.

You have, in effect, created two slides. Since MacroMind Director
plays the slides in order from left to right, the presentation in its
current state will play the bullet chart first, then the MacPaint
document.
In a moment you will make these two slides into one slide, but first
take a look at how it works now.
1. C l i c k  the close box to close the Overview window.
2. C l i c k  the Loop button in the Panel to turn it off.

When the Loop button is highlighted (dark) it is on. Clicking it
deselects it (makes it white).
3. C l i c k  Play in the Panel window.

The bullet chart appears first, followed by the border.
You are now going to make these two slides into one slide.
4. C h o o s e  Overview from the Window menu.

The Overview window returns to the screen.
5. D r a g  the Bullet Chart icon named "New Markets" to a position

beneath the MacPaint icon.

SIC4.10F11 Ina
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Fig. 2.8 Dragging one icon below another

MacroMind Director adjusts the icons, making one compound slide.
A compound slide has more than one element in it. In  this case, the
slide consists of a background MacPaint graphic and your bullet
chart. Each compound slide can have several elements, including
different graphic elements and sounds.
How do you know the MacPaint graphic element is in the
background? Because it is above the bullet chart in the Overview
window's working area. Elements in a compound slide are in the
background if they are above other elements.
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Playing your
presentation

It is time to play this slide to see how your compound slide works.
1. C l o s e  the Overview window, then click Play in the Panel.
MacroMind Director plays your presentation on the Stage.
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Fig. 2.9 Playing your presentation on the Stage

You may notice that the background and the bullet chart are not well
aligned. You will adjust their positions in a later part of this tutorial.
Now you need to open the Overview window, to prepare for the
next step.
2. Choose  Overview from the Window menu.
MacroMind Director displays the Overview window again.
In the next section, you will use Auto Animate to create another
slide. Your presentation will then be two slides long.

Creating an Animated Bar Graph
Your presentation stresses the opportunity offered by new holidays.
You believe that your company should offer greeting card lines that
celebrate new holidays (Grandparents' Day), holidays that have not
traditionally been used for sending greetings (Halloween and Flag
Day), and holidays celebrated by significant ethnic groups (Chinese
New Year). To underline the points you want to make, you want to SIOPO4n1
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prepare a bar chart showing how many sales you can expect for each
new holiday.

Title: Sales Results ( T i t l e  Tent Style...) A b c
Vertical
Thousands ( L a b e l  Text A b c

Bar V a l u e :
Bar 1 r iast 5 Bar Style: S o l i d

Bar 2 Midwest 10 Range: m i n  M a l i
Bar 3 West 15 0 2 0

Bar 4 0 Speed: O I
0 I n i t i a l  D e l a y :  short 1 7 M 7 P  longBar 5

Bar 6 0 Ending Delay: short P I T I M P  long

Setting up the bar
chart

1. D r a g  the Auto Animate icon into the working area of the Overview
window.

The Auto Animate dialog box appears.
2. Se lec t  Bar Chart, then click OK.
The Bar Chart dialog box appears.

 B a r  Chart

Preview... ( Cancel ( O K

Fig. 2.10 The Bar Chart dialog box

The Bar Chart dialog box allows you to create a bar chart with
control over the title, labels, bars, and range. As with the Bullet
Chart dialog box, you type the text you want into the boxes on the
left side. In  addition, you type the values for each bar, and decide
the range you want your chart to reflect.
The title of your bar chart is "New Holidays." The first text box is
already selected. As in the Bullet Chart dialog box, you should use
the Tab key to move to the next text box.
3. Ty p e  "New Holidays" in the Title box.
The vertical label you want is "Projected Sales."
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4. T y p e  "Projected Sales" in the "Vertical label" box.

The projections you are presenting are as follows:
Grandparents 1 5  thousand cases
Halloween 1 2  thousand cases
Flag Day 1 0  thousand cases
Chinese New Year 8  thousand cases
5. E n t e r  these labels and values in the Bar labels and Value boxes.

Enter only the numbers in the Value boxes, not the words,
"thousand cases."
Leave the Range set at 0 to 20.
6. C l i c k  Preview.

MacroMind Director displays the preview screen.
7. D r a g  the special Preview window to the upper right corner of the

screen.

MacroMind Director shows you the bar chart as it will look during
your presentation.
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Fig. 2.11 T h e  bar  char t
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Everything looks good except for the bar labels. The text overlaps.
You can return to the Bar Chart dialog box to change the text font
and size.
8. C l i c k  OK.

Changing the text
font and size

When MacroMind Director displays the Bar Chart dialog box,
1. C l i c k  the "Label Text Style" button.
2. C h a n g e  the font to Helvetica (if you have it), or Geneva, and the

size to 12 point.
3. C l i c k  OK.
You can now preview the new bar chart to judge whether your text
adjustment has worked to your satisfaction. Feel free to make any
further adjustments, either to the text itself, or to the font, size, or
style so that the labels fit within the space available for them.
When you have finished making adjustments,
4. C l i c k  OK in the Bar Chart dialog box.
MacroMind Director displays the Overview window again, with
both of the slides you have created represented in it.
To prepare to play your presentation, turn looping back on, and
rewind the presentation.
5. C l i c k  Loop in the Panel.
This selects Loop, turning it back on.
6. C l i c k  Rewind in the Panel.
This rewinds the presentation, preparing to play it from the
beginning. The playback head, a square box surrounding the
number at the top of each column, is returned to the first slide.
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Fig. 2.12 All the icons are in place

You are ready to see your entire presentation.

This time, instead of closing the Overview window to play the slide
show, use the Shift-click combination to close all the windows except
the Stage.
1. Press the Shift key while you click Play in the Panel.
MacroMind Director closes both the Panel and Overview windows
and hides the menu bar. Your presentation begins and continues to
play on the Stage.
When your presentation has played through once, return the menu
bar and the Overview and Panel windows with the Command key
shortcut for Stop.
2. Press Command-W.
(You remember this from Chapter 1. Press the Command key and
type W.) The Stage is again put behind the other windows.
After a while this method of playing and stopping your
presentations will probably become your preferred way to see what
you are working on in the Overview window.
You are ready to make final adjustments to your presentation.
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Making Final Adjustments
So far you have created the slides you want for your presentation.
MacroMind Director lets you make adjustments in both space and
time. You can arrange how separate elements are placed on the
screen, and how quickly they appear.
You have noticed that your bullet chart does not quite fit the border
you are using. You can adjust their relationship in space.
You also notice that the speed of both the bullet chart and the bar
chart is too fast for your speaking style. You can adjust the timing of
the animation.

Adjusting the
background with
Get Info

First adjust the border.
1. C l i c k  Rewind in the Panel.
MacroMind Director returns the slide show to its beginning.
2. S e l e c t  the MacPaint icon in the first slide, then choose Get Info from

the Edit menu.
MacroMind Director displays the border, along with the Get Info
window.
3. D r a g  the Get Info window to the right.
Dragging the Get Info window lets you see the border. I t  is a corner
border, in the upper left corner of the window.
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Adjusting the bullet
chart

6 File Edit Control Window Sound

Fig. 2.13 The Get Info window for the border
The Get Info window (every document you use in an Overview
presentation has one) allows you to change the location of the image
on the screen, and to establish how many seconds to wait before
displaying the image.
You need only change the location. Notice that the mouse pointer
becomes a hand tool whenever it moves outside the Get Info
window.
4. U s e  the hand tool to drag the image higher on the screen.
Your idea is to place the background image on the screen, then
adjust the bullet chart to fit.
5. C l i c k  OK.

Now you can adjust the bullet chart to fit the background.
1. Double-click the Bullet Chart icon named "New Markets" in the first

slide.
MacroMind Director displays the Bullet Chart dialog box.
2. C l i c k  the Animate Title check box to deselect it.

S11410 41r11 . r.3
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Leaving the title static makes it somewhat easier to see the
adjustments you make. You can reactivate this feature later, if you
wish.
3. C l i c k  the Preview button.
MacroMind Director displays the bullet chart preview. You change
the start location of the bullet chart by clicking, not by dragging.
4. C l i c k  beneath the border, to the left of center.
MacroMind Director shows a crosshair that marks the start location
of the bullet chart. The start location positions the upper left corner
of the bullet chart. You may have to click several times to get the
location just right.

Horizontal line marks top
of bullet chart

Vertical line marks left
edge of bullet text

*  F i l e  E d i t  C o n t r o l  W i n d o w  S o u n d

w Markets

•  Sentimental/Romantic

•  Humorous

•  New Holidays
 B u l l e t  Chart Preview

( P l a y Center Cancel

Fig. 2.14 Setting the start location of the bullet chart

Once you have placed the bullet chart in relation to the border,
return to the Bullet Chart dialog box to adjust the speed.
5. C l i c k  OK.

OK
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Fitting the timing to
your speaking style

You need to set the timing of the bullet chart and the bar chart.
Suppose the introduction to your presentation is somewhat leisurely,
and that the bullet chart finishes before you want it to.
Here are several adjustments you can make. The controls for these
features are on the bottom half of the Bullet Chart dialog box.
1. M a k e  the Speed slower by setting it to 10.
Speed is the rate at which the piece of text travels. Slowing down
the speed makes the title and each bulleted item take longer to travel
into place.
You can change the Speed setting by clicking the scroll arrows, or by
dragging the box.
2. M a k e  the "Bullet Delay" longer by setting it to 3.
The Bullet Delay is the amount of time MacroMind Director pauses
between items. Making the bullet delay longer means that each
bulleted item pauses for a few seconds before starting to appear on
the screen.
3. M a k e  the "Ending Delay" longer by setting it to 15.
The Ending Delay will leave the final bullet chart on the screen long
enough for you to go over the distinctions between the three
approaches.
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Fig. 2.15 Timing changed to fit the way you speak

You may want to preview the revised bullet chart. Remember,
however, that the new timing will appear very slow unless you have
prepared remarks to go with the bullet chart!
When you are satisfied with the timing of the bullet chart, return to
the Overview window.
4. C l i c k  OK.
You need to make similar adjustments in the timing for the bar chart.
5. Double-click the Bar Chart icon named "New Holidays."
You can make similar timing adjustments to the bar chart as you did
to the bullet chart.
6. S l o w  the Speed to 7.
This timing change will make the bar chart operate more slowly.
Use Preview to see the changes in action.
When you have finished, return to the Overview window and play
the whole presentation.
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Saving your
presentation

Printing the results

Having created your presentation, you need to save it on disk. Then
you will be able to open it when you need it.
1. Choose  Save As from the File menu.
MacroMind Director displays the Save As dialog box.
2. Ty p e  "Market Show" and then click Save.
MacroMind Director saves your presentation as an Overview file.
This is a small file (about 2.5K) that contains the Auto Animate
instructions and the series of instructions and names of other
documents required to run your presentation.
Overview documents don't contain all the pictures that make up the
presentation. An  Overview document is essentially a list of
documents with information about their order, timing, transitions
and other effects. That's why Overview documents don't require
much disk space.
That's also why an Overview document is sensitive to the initial
location of the documents it uses. The Overview document contains
enough information to find the document it needs. But if you move
that document, it may not be able to find it. You may find it useful
to move the documents you want to use for a presentation into the
folder you will use to create the Overview document. For further
information, see Appendix A: Finding Missing Documents at the end of
this book.
The Auto Animate effects you have just created, however, are not
separate documents. They are part of the Overview document.

Suppose you want to provide handouts for the people you are
speaking to, to remind them of the points you make, and to give
them something to take away from the meeting. You decide to print
the slides you created with MacroMind Director.
From Overview,
1. Choose  Print from the File menu.
MacroMind Director displays the Overview Print Options dialog
box.
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Page Layout panel

Overview Print Options...
Q. Slides: 0  Overview Window

Fill Slides
0  Selected Slides

Page Layout Cancel Print

Fig. 2.16 The Overview Print Options dialog box

As you can see, you have the opportunity to print the slides you
have created, or the Overview window itself. In addition, you can
print all the slides, or just the ones you select in the Overview
window.
Before printing, look at the Page Layout dialog box.
2. C l i c k  the Page Layout button.
MacroMind Director displays the Page Layout dialog box.

Page Layout...
El Print Page Header (Filename and Date)
Ej Print Page Footer:

Frame Printing Options:
I=1 Sintpe Column 1:(»Inal
Z  Border Rround Frame
El Incluilp 1, Fame Numbpr
1=1 Fr amp i. anentIm
El Registration Marks

( Cancel

Scale:
C) 100%
O  50%

25%

( O K

Fig. 2.17 The Page Layout dialog box

This dialog box gives you the opportunity to print identifying
headers and footers on each page, frame borders and registration
marks, and to scale the slides you print.
Feel free to change the scale to see how the Page Layout panel
reflects the choice you make. The choices that are grayed out are for
Director movies only.
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3. C l i c k  the "Print Page Header" check box to deselect it, then click
OK.

For your handouts you don't want the filename and date. You want
the information only. However, leave the border around the frame.
If you want to go ahead and print the slides you have designed, click
the Print button in the Overview Print Options dialog box. Since this
is strictly practice, you can skip actually printing the slides.

Additional Auto Animate Features
Now that you have used Auto Animate to create a bullet chart and a
bar chart, you are familiar with the basic tasks for all the Auto
Animate effects. For each effect you simply type the text you want,
set the font, style, and size, and adjust the location and timing.
Here are short descriptions of the remaining Auto Animate features.

Zoom Text
You can use Zoom Text to make text come toward the viewer,
disappear away from the viewer, or first come toward the viewer
and then disappear away from the viewer. This produces a very
dramatic effect.

Banner
You can use the Banner dialog box to create a message or row of text
that travels across the screen. You can set the repetitions and speed.

Credits
You can scroll any text up the screen. Typically this is a list of rolling
credits or a list of text that travels up the screen, like credits at the
end of a movie. You can justify the text left, right, or center.

Text Effects
Text Effects gives you three effects you can apply to text: Sparkle,
Letter slide, and Typewriter. Sparkle adds an animated sparkle
randomly on top of the text. Letter slide causes each letter to
individually slide into place. Typewriter displays each letter
individually, as though you were typing at a keyboard.
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Summary
Auto Animate is a quick way to create special effects for text and
charts. In this chapter you have seen how to combine the Auto
Animate effect with a background image and how to adjust the
location and timing of the images.
You have also become familiar with the basic operations of the
Overview window, dragging icons into the working area to create a
presentation, moving an icon to combine it with another, and
selecting an icon before using Get Info.
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Chapter 3: Overview Tutorial

i n  addition to making simple text animation a snap to
create, Overview gives you the tools to create multimedia
presentations that can include whatever it takes for your
audience to visualize your message. You can combine
graphics, sounds, Director movies, animated titles, and
transitions to add sizzle to your communications. You
can even print out copies of your presentation to create
handouts for your audience.
This tutorial shows you how to put together a
MacroMind Director Overview presentation, animating a
static graphic image with transitions, and adding clip
animation to add drama. The tutorial builds on skills
you learned in the previous tutorial.
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Starting Up
Overview presentations can be used in many ways. They can
advertise, they can entertain, or they can educate. The content is as
varied as the people that create the message. For this tutorial,
suppose you are a history teacher. You'll create a short history
lesson about the first transcontinental railroad in the United States.
You've decided to use MacroMind Director so that your students can
visualize the event.
The subject of this presentation is a significant one. The joining of
the rails across America linked the West and East coasts of the
United States, setting the stage for western expansion and migration.
To make this date memorable, you'll use Overview to assemble
several MacPaint documents, and then you'll use a transition to
animate the progress of the rails.
While you create the history lesson, you'll also learn about moving
forward and backward in an Overview document and how to set
timers so each slide remains on the screen for the right length of
time.
If you have just completed the previous tutorial and are in
Overview, you can simply open the file indicated in the next section.
Before you begin I f  you are working with a color Macintosh, set the
monitor to "Black & White/Grays," 2 Colors, using the Control
Panel desk accessory.
If you haven't started MacroMind Director, do so now.
1. S t a r t  MacroMind Director.
MacroMind Director starts up.

Opening an
Overview document

The Overview document used in this tutorial is called Joining of the
Rails. You can find the document in the MacroMind Director folder
called Overview Tutorial on your hard disk.
1. L o c a t e  the Tutorials folder on your hard disk and open it.
2. L o c a t e  the Overview Tutorials folder and open it.
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The Overview Tutorials folder contains folders for all the tutorials
used in this book.
3. L o c a t e  the Overview Tutorial folder and open it.
Joining of the Rails is in the Overview Tutorial folder.
4. O p e n  Joining of the Rails.
The Joining of the Rails Overview window displays the icons shown
in the illustration below. As you can see, the working area of the
Overview window has several MacPaint icons and a Director icon.
These represent the documents used in the presentation.

4  F i l e  E d i t  C o n t r o l  W i n d o w  S o u n d

Joining o f  the Flails Overview

XI
 8

Railmeet

Fig. 3.1 T h e  Joining o f  the Rails Overview w indow

The other icons in the Overview window represent timers that
control the duration of the slides on the Stage, and transitions that
control how the presentation moves from one slide to another.

To see the effect of the timers and transitions on the presentation, go
ahead and play Joining of the Rails.
1. Press Shift and click Play in the Panel.
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This Shift-click combination closes the Panel and Overview window
and plays the Joining of the Rails presentation. Since the presentation
is set to loop, it will continue to play until you tell it to stop.
Missing files? If any of the documents are missing, MacroMind
Director will tell you that it can't find them, and give you a chance to
locate them (perhaps they were moved to a different folder or
renamed). See Appendix A: Finding Missing Documents at the end of
this book for more information.
2. Press Command-W to stop the slide show.
The menu bar, Overview window, and Panel all reappear. You are
by now familiar with this sequence of playing and stopping
Overview presentations. Subsequent directions simply tell you to
play and stop the presentations, without stating all the directions.

Recreating Joining of the Rails
To learn about assembling a presentation, let's recreate the show you
just played. You will see how to add documents and effects to a
presentation.
Joining of the Rails contains three MacPaint documents and one
Director movie. The MacPaint documents are static graphics that are
used either as simple slides or in the background of compound
slides.
The Director movie is a clip animation arrow that has been added to
emphasize a point about the slide. Clip animation is like clip art, a bit
of useful animation you can add to underscore your message. In this
case the clip animation points to Promontory, Utah on the map.
Promontory is, of course, the spot where the rails finally joined.

Opening a new
Overview document

The first step in recreating the presentation is to open a new,
Untitled Overview document.
1. Choose  New from the File menu.
A new Overview window appears. You can now begin assembling
the slides for your show. You add documents to your presentation
by dragging icons.
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Fig. 3.2 The icons in the icon bar represent types of documents and effects

The first slide of Joining of the Rails is a MacPaint document called US
Map 1.
1. D r a g  a MacPaint icon from the icon bar to the working area of the

Overview window.
The directory dialog box appears. The names of the MacPaint
documents in the current folder appear here. You will find US Map 1
in the Overview Tutorial folder.
2. O p e n  US Map I.
A highlighted MacPaint icon appears in the first slide position at the
left of the Overview window working area. The title below the icon
shows that it's US Map 1. SlOpOgli
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Fig. 3.3 The Overview window with the first slide highlighted
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Adding a second
slide

The second slide will be a compound slide. A  compound slide has
more than one document stacked in the slide's column. In this case,
the MacPaint document serves as a background while the Director
movie contains the animated arrow. The Director movie appears
overlayed on the MacPaint map.
The higher an icon appears in the column of icons in a compound
slide, the farther in the background it appears on your slide.

Background
Background

l a g

Chart 1

• Or ' I  •

Chart 2

 F o r e g r o u n d

Chart 3

Fig. 3.4 The order of icons in the column determines foreground and background
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To create the second slide,
1. D r a g  a MacPaint icon from the icon bar to the Overview window

working area.
Position the icon to the right of the first slide. Since Overview plays
slides from left to right, placing US Map 2 to the right of US Map 1
makes US Map 2 the second slide in the presentation.
When you release the mouse button, the directory dialog box
appears.
2. O p e n  US Map 2.
A MacPaint icon representing US Map 2 appears in the working area.
3. D r a g  a Director movie icon from the icon bar to the Overview

window working area, below US Map 2.
Position the icon below US Map 2. This position establishes the
Director movie in front of US Map 2 in the second slide.
When you release the mouse button, the directory dialog box
appears. Notice this time you see the names of Director documents
in the directory dialog box and no others. That's because the list of
documents in the directory dialog box reflects the type of document
icon you drag into the working area.
4. O p e n  Arrow.
The Director movie icon appears below US Map 2. Now you've
created a compound slide with a MacPaint map and the Director
movie.

SlOpOirli . c..)
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Fig. 3.5 The first two slides of Joining of the Roils
By the way I f  you mistakenly place an icon in the wrong column,
you can always drag it to its proper location in the Overview
window working area. In fact, to change the order of the slides in
your presentation, you drag the icons to a new location.
Note that MacPaint documents can be placed in the foreground or
background. This is true for PICT and Glue documents as well.
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Adding the third
slide

The third slide is a MacPaint document containing a picture of the
rail workers celebrating the completion of the rail line. When you
drag this icon from the icon bar, position it to the right of US Map 2.
1. D r a g  a MacPaint icon from the icon bar to the right of the second

slide's column.
The directory dialog box opens.
2. O p e n  Railmeet.
The MacPaint icon for Railmeet appears in the third slide's column.
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Playing the slide
show
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Fig. 3.6 The three slides of your presentation

Although your slide show is not yet finished, you should play it to
make sure your slides are in the correct order.
1. P l a y  the presentation.
You can Shift-click Play in the Panel to bring the Stage to the front
and hide the other windows. MacroMind Director plays your
version of Joining of the Rails.
It's clear that the presentation still needs editing. You need to adjust
the timing and positioning of the slides and add a few transitions as
you move from slide to slide.
After you've seen the show flash by a few times, stop the slide show.
2. S t o p  the presentation.
You can use Command-W to stop the presentation and return the
Overview and Panel windows to the front.

Editing the Slide Show
Assembling the documents that make up your presentation is the
first step in working with Overview. The second step is refining the
presentation with the tools at your disposal in the Overview

Slq.10.1% M co
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window. The first step is to slow the slide show so your audience
can understand what's going on. Then you can reposition the slides
accurately. Finally, you can add transitions that animate the
presentation.
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Adding timers
Timers determine how long a slide remains on the Stage. To adjust
the timing of this presentation, you'll use two timers. The first timer
will set the duration of the first two slides. The second timer will be
a longer one so the last slide remains on the Stage while your
audience absorbs the message.
1. D r a g  a timer from the icon bar to a spot below the document in the

first slide.
When you release the mouse button, a blinking insertion point
appears below the timer. You need to type the length of time you
want this slide displayed.
2. T y p e  "4," then click anywhere in the working area or press Return.
You've just set the timer for four seconds. A l l  the slides to the right
of the timer will also be displayed for four seconds unless you insert
another timer, or a Director movie is in one of the slides. Director
movies have their own duration that controls the duration of the
slide.

Fig. 3.7 Setting the first timer to four seconds

The duration of each slide appears above each column of icons. The
number 4 indicates that the slide will display for four seconds. The
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Duplicating an icon
with the Option key

ff• U n t i t l e d  Overview J

/

L
. I l a -'

u

•IrijI,"
•,... .....--- i l F 0 00

_

.0.

US

E N

Map1 U S

m

Map

• I V

2 R a i l m e e t

8

Lin ........

4

i n ,
• 1,71•
Arrow 8

<3 E > g]

letter M indicates the duration of that slide is controlled by a
Director movie in the column.

Now you can add a second timer to control the duration of the last
slide. In  this step you will learn a particularly useful technique to
duplicate an icon.
To set the second timer,
1. Opt ion-drag the four second timer to a position beneath the last

slide.
Pressing the Option key while dragging an icon duplicates that icon.
Use Option-drag whenever you want to duplicate any icon in the
working area of the Overview window.
The timer you just placed in the third slide's column is still set for
four seconds. To change the duration of the timer,
2. C l i c k  the number 4 beneath the timer you duplicated.
Clicking the number selects it. You can also drag across the number
to select it as you would in a word processor.
3. Ty p e  "8," then click anywhere in the working area or press Return.
The second timer is now set for eight seconds. Play the slide show to
see the effect of the timers you just set.

Fig. 3.8 Setting the second timer to eight seconds
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4. S h i f t -click the Play button in the Panel.
The Stage is cleared of all the windows and the slide show begins.
At the end of the slide show,
5. Press Command-W to stop the show and reveal the windows.
The timers have improved the slide show, but the arrow is not even
in the state of Utah and the rails don't move toward each other.
They just appear on the screen. Further editing is needed before the
slide show is finished.

Repositioning an
image

Earlier you learned that a compound slide is made with several
documents in layers. The second slide has a MacPaint map as a
background and a Director movie overlay that animates the arrow.
Currently, the arrow points to the desert of eastern Nevada, several
hundred miles from Promontory, Utah. You'll have to reposition the
arrow with Get Info.
1. Double-click the Director icon named Arrow in the Overview

window.
MacroMind Director displays the Get Info window for the Arrow
movie. Double-clicking an icon is a shortcut for selecting the icon
and choosing Get Info from the Edit menu.
Each type of document, MacPaint, PICT, Glue—, Director movie, and
MacroMind Accelerator"' movie, has its own type of Get Info
window. Most of the Get Info windows allow you to reposition the
document on the Stage and choose a delay for the appearance of the
document. Some Get Info windows, like the ones for Director and
Accelerator movies, provide additional options for repeating the
animation or holding the first or last frames of an animation. An
animation frame is a snapshot of an animation. A  complex
animation can include thousands of individual frames.
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Get Info
Info About: Arrow

Timing: l  Use Movie's Normal Length
0  Use Current Timer Length
Repeat Movie:

Start After: 0

Times

Seconds

Position: CD Use Movie's Start Location
0  Set Start Location With Mouse
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Z  After Movie Ends, Last Image Remains
El Play Movie's Sounds

L C a n c e l OK

Fig. 3.9 The Director movie Get Info window

You'll use the "Position" option in the Get Info window to reposition
the movie.
To reposition the movie,
2. C l i c k  "Set Start Location With Mouse."

3. D r a g  the Get Info window to the bottom of the screen.

With the Get Info window out of the way, you can get a clear view of
the map and animation. When you move the pointer from the Get
Info window, it turns into a crosshair. You can reposition the movie
with the crosshair pointer.
4. C l i c k  Promontory, Utah, with the crosshair.

Each time you click, the arrow animation plays, allowing you to see
where you've positioned the arrow. Click until the point of the
arrow is positioned on Promontory, Utah.
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Using a transit ion
to animate
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Fig. 3.10 Positioning the arrow animation with the crosshair
5. D r a g  the Get Info window so you can see all of it.
You still need to set a delay in the Get Info window so that Map 2 is
displayed for a few seconds before the arrow moves.
To set a delay for the movie,
6. S e l e c t  the number in the "Start After" box.
7. T y p e  "3" in the "Start After" box.
This will delay the start of the movie for three seconds. In other
words, US Map 2 will be shown for three seconds before the arrow
appears.
8. C l i c k  OK.
You've just repositioned and delayed the movie. The next step is
adding transitions.

Transitions are used to move smoothly from slide to slide. They are
like the dissolves, wipes, and reveals a film or video editor uses to
move from scene to scene. In Joining of the Rails, transitions are used
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to move from slide to slide and to simulate animation. The animated
effect of the rails reaching toward each other is created with a
transition from slide one to slide two.
Notice that the two MacPaint documents US Map 1 and US Map 2 are
exactly alike, except that US Map 2 has the path of the railroad
drawn on it. The transition between the two slides will cause the
differences between the two slides to be animated. In this case, it
will grow from the two ends toward the middle.
To set the transition that makes the rails grow toward one another,
1. D r a g  the transition icon from the icon bar to a position between the

first and second slides.
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Fig. 3.11 Position the transition icon between the first and second slides

The Set Transition dialog box appears. There are many transitions
for you to choose from. Each transition is described and illustrated
in the dialog box. The transition that makes the rails grow towards
one another is Edges in, horizontal.
The Set Transition dialog box also permits you to set the Duration
and Chunk Size for each transition. Duration is the amount of time it
takes for the transition to occur. I t  is set in quarter seconds. There is
no preset value for Duration. Chunk Size controls the number of
pixels that change in each step of a transition, thus affecting the
apparent smoothness of the transition. The preset Chunk Size value
for each transition is carefully chosen to make the transition
effective. You can set Chunk Size from 1 to 128 pixels.
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Adding more
transitions
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Fig. 3.12 The Set Transition dialog box has several transitions to choose from

To choose this transition,
2. C l i c k  "Edges in, horizontal" in the Set Transition dialog box.
You may need to scroll the list of transitions to find it.
This transition is like a pair of barn doors closing towards the center
of the Stage. The first slide remains on the screen while the second
slide appears at the sides of the Stage and moves towards the center.
As the transition progresses, the railway appears to grow from the
edge of the Stage towards the center.
The duration for this transition is very important, since it controls
the appearance of the rails "growing."
3. S e t  Duration to 16.
The transition will last 4 seconds, long enough for your audience to
understand what they are seeing.
For this transition, you can use the default value for Chunk Size.
4. C l i c k  Set Transition.

You have two more transitions to place to complete the slide show.
The next transition goes between slides two and three.
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1. D r a g  a transition icon from the icon bar to a position between slides
two and three.

The Set Transition dialog box appears.
2. C l i c k  "Center out, square."

This transition will start at the center of the Stage and expand,
revealing the third slide beneath the second slide.
3. S e t  Duration to 4.

It will take one second for the transition to occur.
4. C l i c k  Set Transition.

The final transition goes after slide three.
5. D r a g  a transition icon from the icon bar to a position to the right of

slide three.

The Set Transition dialog box appears.
6. C l i c k  "Edges in, square," set Duration to 4, and click Set Transition.

The final transition makes a nice way to cut back to the first slide
when the slide show loops.

❑ U n t i t l e d  Overview

Fig. 3.13 The complete recreated Overview document
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Wrapping Up
Now that you've assembled the slide show, added timers and
transitions, and used Get Info to reposition and set a delay for the
Director movie, it's time to enjoy the show.

Playing the slide
show

To play the slide show from the beginning, you'll need to rewind the
show.
1. Rewind the presentation.
The show rewinds to the first slide.
2. P l a y  your presentation.
The slide show plays, displaying the documents and effects you
selected.
When the slide show is over, take a break and come back for the next
tutorial when you're ready.

Summary
You have put together a complete presentation, using transitions to
provide an animated version of a historical sequence. In addition,
you have used one piece of clip animation to add impact to the
presentation.
You added timers to the presentation, to control how long each slide
is shown. You repositioned the Director document, and you set a
delay so that it appears when you want it to.
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Chapter 4: Advanced Overview Tutorial

Overview slide shows can be as ambitious as your
imagination allows. The slide show you created in the
previous tutorial was relatively simple. There was only
one compound slide. In this tutorial you'll work with a
more sophisticated slide show that uses clip animation to
create compound slides. You'll also get a chance to add
sound effects to your presentation.
Although Bamboo Industries, the presentation you'll create
in this chapter, is more complex, it's just as easy to
assemble as Joining of the Rails. That's because clip
animation is a great labor saving invention, as you saw in
Joining of the Rails. You don't have to know anything
about animation to use it. In this tutorial, you'll use clip
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animation to overlay shimmers and arrows on your slides. You'll
also learn more about editing and controlling an Overview slide
show.

Starting Up
Suppose you are preparing an animated presentation for a client, a
chopsticks manufacturer, to use at a sales meeting. You have
gathered all the information you need, and have obtained graphic
images from the company. Your job is to assemble them into an
animated visual statement that will excite the salespeople.
If you have just completed the previous tutorial and are in
Overview, you can simply open the file indicated in the next section.
Before you begin I f  you are working with a color Macintosh, set the
monitor to "Black & White/Grays," 2 Colors, using the Control
Panel desk accessory.
If you haven't started MacroMind Director, do so now.
1. S t a r t  MacroMind Director.
MacroMind Director starts up.
By the way For the last (optional) step in this tutorial, you'll need a
copy of MacPaint so you can edit one of the slides. I f  you own
MacPaint, put it on the same hard disk as MacroMind Director.

Opening Bamboo
Industries

You can find the Bamboo Industries Overview document used in this
tutorial in the MacroMind Director Advanced Overview Tutorial
folder.
1. L o c a t e  the Advanced Overview Tutorial folder inside the Overview

Tutorials folder.
Bamboo Industries is in the Advanced Overview Tutorial folder.
2. O p e n  the Advanced Overview Tutorial folder.
3. O p e n  Bamboo Industries.
The Bamboo Industries Overview window displays the icons that
represent the documents used in the presentation.

62 S t a r t i n g  Up



Changing the
speaker volume

•
0
R E W

11
BACK

..
El

l S T E P

I
PLAY LO P

5 Bamboo Logo Chopstick Mkt Chopsticks Today

:
21C :

• r -N• •11",l• • r
Presenting Peaking Left Arrow

'11•

Intro1 Transition 1 Left Arrow

*  F i l e  E d i t  C o n t r o l  W i n d o w  S o u n d

=Ei B a m b o o  I n d u s t r i e s  O u e r u i e w

DOOD0 LI0

1A1

M

IAN

iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiila!

Fig. 4.1 The slides that make up Bamboo Industries appear in the Overview
window
You can see that there are more compound slides in Bamboo
Industries than in Joining of the Rails. Sound effects have also been
added. Sound effects icons look like ears and have the name of the
sound below them.

Bamboo Industries uses several sounds in the presentation. This is
probably a good time for you to check the Control Panel to make
sure your speaker volume is turned up as high as possible.
1. Choose  Control Panel from the Apple menu.
The speaker volume should be at the top of the scale. I f  it is not,
2. D r a g  the speaker volume knob up.
Dragging the speaker volume knob up increases the volume. I f  your
Macintosh is connected to external speakers you may not have to
drag the knob all the way to the top.
3. C l o s e  the Control Panel.
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Now you'll be able to hear the sound effects you add to your slide
show.

Playing Bamboo
Industries

Now you can play Bamboo Industries to see the presentation, but first
you want to turn off looping.
1. Deselect Loop in the Panel.
The Loop button turns white to indicate that looping is turned off.
2. Press the Shift key and click the Play button in the Panel.
The slide show begins on the Stage.
Missing files? If any of the documents are missing, MacroMind
Director will tell you that it can't find them, and give you a chance to
locate them (perhaps they were moved to a different folder or
renamed). See Appendix A: Finding Missing Documents at the end of
this book for more information.
As the slide show progresses, you'll see examples of clip animation,
view several transitions, and hear sound effects. When the slide show
ends, the Overview window and the Panel reappear.
If for some reason the slide show does not stop or the windows do not
appear,
3. S t o p  the presentation.
Use the Stop command on the Control menu or press Command-W.
MacroMind Director automatically redisplays the Overview window
and Panel.

Moving the
playback head

Sometimes you need to go directly to a specific slide. I f  the slide
show is a long one, you won't want to wait as the slide show plays to
the slide you want to edit.
The playback head is the box that travels at the top of the Overview
window working area. I t  has two purposes. Its position indicates
which slide is currently displayed, and you can reposition it to
quickly jump to a particular point in the slide show.
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Playback head
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Fig. 4.2 The playback head indicates the currently displayed slide

To reposition the playback head at a specific slide,
1. C l i c k  above the third slide, Chopsticks Today.
Clicking the area above the slide, where the timing information is,
advances the playback head to that slide. Chopsticks Today is now
displayed on the Stage. Try clicking above other slides to display
them on the Stage. This is particularly useful when you are creating
your slide show and need to edit a specific slide.
iqk Tips & Hints You can also control your slide show with keyboard
commands. For a complete list, see Controlling an Overview Document
in Chapter 5: Using Overview.

Editing Bamboo Industries
This tutorial is primarily concerned with editing a complex
presentation. I t  concentrates on showing you how to make careful
adjustments using documents that already exist. To give you a head
start in recreating the Bamboo Industries slide show, a partial slide
show called Partial Bamboo is in the Advanced Overview Tutorial
folder. Most of the icons that make up the slides are already in place.

SlOpOpli 111 P.
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You'll add and edit clip animation, sounds, and transitions to
complete the slide show.

....
14
REW

41
BACK

• I
STEP PLAY LOOP

M  5  5 5

AN
5 BambooLogo

raVacii

Chopstick Mkt Chopsticks Today

Presenting

Opening Partial
Bamboo

1. Choose  Open from the File menu.
If you are asked whether to save changes to Bamboo Industries, click
Discard.
MacroMind Director displays the directory dialog box.
2. O p e n  Partial Bamboo.
The Partial Bamboo Overview window displays the icons that
represent the documents used in the presentation.

st F i l e  Ed i t  Control Window Sound

Partial Bamboo Oueruiew

at
Fig. 4.3 The Overview window of Partial Bamboo

Playing Partial
Bamboo

You can play Partial Bamboo to get an idea of the slides that are
currently in the presentation.
1. P l a y  Partial Bamboo.
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Adding clip
animation

As long as Loop is turned off, when the slide show ends, the
Overview window and Panel return to the screen.

Using Clip Animation
Clip animation can draw attention to key points in a slide show. A
piece of clip animation is a Director movie. Use the clip animation
library in the Clip Media folder to add animation to your
presentations without creating the animation from scratch. You can
also buy additional disks of clip animation from third party vendors.
Ask for them at your computer or software store.
In Bamboo Industries, you'll use clip animation to add arrows,
shimmers, and borders to specific slides.

The first piece of clip animation you'll add is a Director document
called Left Arrow. The arrow will come from the left and move to the
right. You are going to add this arrow to the Chopsticks Today
document.
1. D r a g  a Director movie icon from the icon bar to a spot beneath the

' Chopsticks Today document.
The directory dialog box appears. Left Arrow can be found in the
Advanced Overview Tutorial folder.
2. O p e n  Left Arrow.
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Partial Bamboo Overview

Using Get Info to
position clip
animation

moo
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Bamboo Logo
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Chopstick Mkt
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IAN
Chopsticks Today

Fig. 4.4 Left Arrow appears below Chopsticks Today

The Left Arrow icon appears below Chopsticks Today.

The next step is to position the clip animation so the arrow points to
the right spot on your slide.
1. Double-click the Left Arrow icon.
The Get Info window appears. Double-clicking the icon is a shortcut
for selecting the icon and choosing Get Info from the Edit menu.
You can use the Get Info window to set a delay, loop the animation,
hold the first or last frame, or position the clip animation. Right
now, you'll use it to set the position of the clip animation.
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 G e t  Info
Info About: Arrow

Timing: 0  Use Movie's Normal Length
0  Use Current Timer Length
Repeat Movie: 1  T i m e s

Start After: 0  S e c o n d s

Position: 0  Use Movie's Start Location
0  Set Start Location With Mouse
Horiz: 0  V e r t i c a l : 0

❑  Before Movie Starts, First Image Appears
0  After Movie Ends, Last Image Remains
0  Play Movie's Sounds

i C a n c e l ( OK

Fig. 4.5 The Get Info window allows you to set timing and position options for
Director movies

The Position options allow you to use the start location of the
animation as it was created in Studio, or set the start location with
the mouse. You'll use the mouse to set the start location of the
arrow.
First move the Get Info window out of the way so you can see where
you are positioning the animation.
2. D r a g  the Get Info window to the lower part of the screen.

This gives you an unhindered view of the Stage.
3. C l i c k  a spot next to the phrase "Chopstick sales off in the Far East."

The arrow appears and moves from left to right. I t  may take a few
tries before the arrow stops just to the left of the phrase you want to
call attention to. When you are satisfied with the position of the
arrow,
4. D r a g  the Get Info window so you can see all of it, then click OK.

The Overview window is displayed again.
sIouo�nl UA
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Duplicating an icon
with the Option key

Now you can add a second arrow to highlight the second phrase,
"The West: a growth opportunity." You'll set a delay so the arrow
appears after the first arrow.
Use the Option-drag technique to make a copy of the arrow.
1. H o l d  the Option key and drag the Left Arrow icon down to a spot

directly below the icon.
As you remember, when you hold down the Option key while
dragging, you make a copy of the icon. When you release the mouse
button, the copy is created.

Using Get Info to
delay clip
animation

_❑ Partial Bamboo Oueruiew

3 r: 0 0 0 0

5

M

Bamboo Logo

: :

Presenting

 5

Chopstick Mkt Chopsticks Today
14

Left Ar row

'0`

,1377

al
Fig. 4.6 The second Left Arrow appears in the same slide as the first Left Arrow

If you played the slide show right now you wouldn't see the second
arrow because it occupies the same position as the first arrow. You
have to set a new starting point and a delay for the second arrow.

You can now set the position and timing options for the second
arrow.
1. Double-click the second Leff Arrow icon.
The Get Info window appears.
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Adding a shimmer

2. Ty p e  "2" in the "Start After" box.
By typing 2 in the "Start After" box you will delay the appearance of
the second arrow for two seconds.
Now you are ready to position the arrow. Again, you'll have to
move the Get Info window out of the way so you can see where you
are positioning the animation.
3. D r a g  the Get Info window to the lower part of the screen.
Now you can see the Stage.
4. C l i c k  a spot next to the phrase "The West: a growth opportunity."
The arrow appears (after 2 seconds) and moves from left to right. I t
may take a few tries before the arrow stops just to the left of the
phrase you want to call attention to. When you are satisfied with the
position of the arrow,
5. D r a g  the Get Info window so you can see all of it, then click OK.
The Overview window returns to the screen.
6. P l a y  the slide again to see the effect.
You have now practiced using the Get Info window. Subsequent
directions assume you know the particular steps.

You may have noticed in the first slide of Bamboo Industries that after
the word PRESENTING appeared, a series of shimmers ran across
the word. In that case, the shimmer was part of the Director movie
called Presenting.

Fig. 4.7 The shimmer passes over the word PRESENTING
The shimmer can also be added using clip animation to anything
that appears on the Stage. In this example, you'll add a shimmer to
the words "Industry Leader" in the Why Bamboo document. Shimmer
can be found in the Advanced Overview Tutorial folder.
To add a shimmer,
1. Scrol l  the Overview window until you see the Why Bamboo icon.
2. D r a g  a Director movie icon from the icon bar to a spot beneath Why

Bamboo.
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The directory dialog box appears.
3. O p e n  Shimmer.

Repeating the
shimmer

Once the Shimmer icon appears beneath Why Bamboo, you can use the
Get Info window to repeat and reposition the shimmer.
1. Double-click the Shimmer icon in the Overview window.
The Director movie Get Info window appears. You will set the
number of times for the shimmer to repeat and the position of the
shimmer.
To set the number of repeats,
2. Ty p e  "4" in the "Repeat Movie" box.
The clip animation will now repeat four times. The next step is to
make sure the shimmer appears on the words "Industry leader."
Using the mouse to set the start location, click the "I" in "Industry."
The shimmer will start where you clicked and move from left to
right. I t  may take a few tries before the shimmer covers all the
letters. When you are satisfied with the position of the shimmer,
3. C l i c k  OK to return to the Overview window.

Adding a border
The last bit of clip animation you'll add is a border around the Why
Bamboo document.
1. D r a g  a Director movie icon from the icon bar to a spot beneath the

Shimmer icon.
The directory dialog box appears.
2. O p e n  Border.
Border can be found in the Advanced Overview Tutorial folder. The
Border icon appears below Shimmer in the Why Bamboo slide. You'll
reposition the border so it encloses the words in Why Bamboo.
3. Double-click the Border icon.
The Get Info window appears. Use this window to set the position
of the border. Using the mouse to set the start location, the point
you click will be the center of the top line of the border. I t  may take
a few tries before the border is centered.
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Saving your work

4. C l i c k  OK to return to the Overview window.
You have finished placing all the clip animation you'll use in this
slide show. Take a look at what you've done so far.
5. Rewind and then play Partial Bamboo.
Your presentation is almost complete. You will add sounds and two
additional bits of text in the next sections.

It is always a good policy to save your work periodically, so that you
are protected from disasters such as power failures that wipe out
whatever is in memory.
1. U s e  Save As to save this document as Partial Bamboo 2.
If you'd like to take a break now, come back when you are ready to
continue.

About Sound
Sound can add an extra dimension to your presentations. You can
use sound effects (a shoe dropping with a clunk, wind whistling, and
so forth) or music that accompanies and underscores your images
(soft, soaring, jazzy).
MacroMind Director comes with a selection of sounds in a file called
Sounds in the Sounds folder. The Sounds file should be in the same
folder as the MacroMind Director application, in the same folder as
the Overview document you are creating, or in your System folder.
If you want to learn more about sound files, or how to add your own
digitized sounds to a Sounds file, see Adding Tempos, Transitions, and
Sound in Chapter 5: Using Studio in the MacroMind Director Studio
Manual. For the present example, you'll use the sounds from the
Sounds file included with MacroMind Director.
111* Tips & Hints You can use different names for sounds files. You
instruct MacroMind Director what name to look for by choosing
Preferences from the Control menu. Click the Sounds File entry box
in the Preferences dialog box to locate the sounds file.
in, Your Macintosh is equipped with a small internal speaker. When
you present a slide show to a large group, you will probably want to
use an external speaker for better sound quality. The speaker cable
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you need depends on the Macintosh model you are using. I t  can be
obtained at any electronics supply store. Use the cable to connect the
sound port of your Macintosh to an amplifier or an amplified
speaker.

Adding sounds to
Partial Bamboo

You have heard sounds already in Bamboo Industries and Partial
Bamboo. The ChopSticks movie includes the sound of chopsticks
breaking apart. You don't see a sound icon in that slide's column
because the sound is in the Director movie document (the clip
animation). When the ChopSticks movie was added to the
presentation, the sound came with the movie.
In this example you'll add sounds to two slides in the Overview
window using the sound icon in the icon bar. Sounds that are part of
Director movies do not show in the slide's column.
1. Resize the Overview window to make a larger working area.
Click the zoom box or drag the size box.
2. I f  necessary, scroll the Overview window so the first slide appears.
3. D r a g  a sound icon from the icon bar and place it in the first slide's

column.
The first slide is headed by the MacPaint document, Bamboo Logo.
The sound icon remains highlighted and the word "default" appears
below the icon. When the sound icon is highlighted, you can assign
a sound with commands in the Sound menu.
4. Choose  Intro1 from the Business submenu in the Sound menu.
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Sound menu

Business submenu

Sound
as1

MIDI
1 -  Basic
2 -  EHplosions
3 -  Weapons
4 -  Instruments
5 -  Nature
6 -  Space
7 -  Old Music
8 -  New Music

▶

▶
▶
▶
▶
▶
▶
▶
▶

9 -  Business ▶  9 - 1  I n t r o l
E -  Sampled 1 ▶
F -  Macintalk ▶

9-2 Intro2
9-3 Intro3
9-4  I'm Here
9-5 Mini Fanfare
9-6 Bad Times
9-7 Ending
9-8 Transition 1
9-9 Transition 2
9-H Transition 3
9-B Transition 4
9-C Transition 5
9-0 Transition 6

Fig. 4.8 Choosing a sound

Introl now appears below the sound icon to indicate that sound will
accompany the first slide.
Note I f  no sounds appear in the Sound menu, MacroMind Director
is having trouble finding the Sounds file. Make sure the Sounds file is
in the same folder as MacroMind Director.
Now you can add a sound to the next slide.
5. D r a g  a sound icon from the icon bar and place it in the second

slide's column.

The second slide is headed by the MacPaint document, Chopstick
Mkt. The sound icon remains highlighted, waiting for you to assign
a sound from the Sound menu.
6. C h o o s e  Transition 1 from the Business submenu in the Sound menu.

The second slide will now play Transition / when it appears on the
Stage.
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Go ahead and look at the results.
7. Rewind and then play Partial Bamboo 2.
The sounds you have added play with the slides as they appear on
the Stage.

Sound and timers
In the case of the two sounds you just added, the slides appeared on
the Stage long enough for the complete sound to play. However, not
all sounds are so short. You may use a sound that lasts longer than
the slide. In that case the sound will be cut off when the timer
expires and the show moves on. The solution is to add a timer that is
as long or longer than the sound. That way you'll be able to play the
whole sound before you move on to the next slide.

Modifying a Slide
After you assemble a slide show, you may occasionally find that you
need to make last minute revisions in the content of one of your
slides. In this example, you'll change the MacPaint document in the
first slide, Bamboo Logo.
Suppose you want to add your own name to the first slide, giving
yourself credit for preparing the presentation. You can modify the
first MacPaint document directly from within Overview.

Starting an
application with
Launch Editor

To modify an existing document, you can use the Launch Editor
command in the File menu. Launch Editor bypasses the Finder and
opens the application that created the selected document.
This step is optional, of course. I f  you don't have MacPaint, or
another paint program that can create MacPaint documents, simply
go on to the next section. I f  you are using another paint program,
see the Tips & Hints note at the end of this section. Also note that if
you are using MultiFinder, you need enough memory to run both
MacroMind Director and MacPaint at the same time.
1. C l i c k  the Bamboo Logo document.
The document highlights to indicate that it is selected.
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2. Choose  Launch Editor from the File menu.
MacroMind Director displays a Save dialog box. You need to save
your Overview document before going to MacPaint.
3. C l i c k  Save.
Launch Editor starts up MacPaint.
If MacPaint is available, you'll soon see MacPaint with Bamboo Logo
in the window.
4. C l i c k  the text tool.
5. P l a c e  an insertion point near the bottom of the window.
You are going to add your name to the bottom of the first slide.
6. Ty p e  "prepared by:" then add your name.
Type your own name.
7. S a v e  the modified document, then quit MacPaint.
When you quit an application that has been started by Launch
Editor, you will return directly to Overview.
The changes you made to the Bamboo Logo are now in the first slide.
Take a look at it.
8. P l a y  the first part of Partial Bamboo 2 to see the result.
Your note has been added to the document.
ni* Tips & Hints You can determine which application starts when
you use Launch Editor. Use the Preferences command on the
Control menu.

Using Auto Animate in Studio
The last step in this tutorial will be your first step into the Studio
portion of MacroMind Director. You have decided to add an
animated text effect to the second slide, Chopstick Mkt. You will use
Auto Animate to create a zoom effect for "Demand is Peaking." But
you want to modify the effect, adding a border around the text. For
this you must use Auto Animate in Studio.
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When you create an Auto Animate effect in Studio, it becomes a
Director movie, which you can modify with any or all of the
powerful Studio tools.
The following steps show you how to move quickly between the
Overview and Studio portions of MacroMind Director. The tutorial
introduces you to some of the basic windows and tools in the Studio
portion of the program.

Creating a Director
movie overlay

Once you've built a slide in the Overview window, you can create a
Director movie overlay for that slide. An  overlay is a piece of
animation that you create to play on top of the image that is already
in the slide.
To create an overlay,
1. D r a g  a Director movie icon from the icon bar to the bottom of the

column of the second slide.
The second slide is headed by the MacPaint document, Chopstick
Mkt. The directory dialog box appears, asking which Director
document to use in this slide.
2. C l i c k  New.
You want to create a Director document from scratch. A  dialog box
appears and asks if you want to save changes in your Overview
document.
3. C l i c k  Save.
Your document is updated, and the Studio is launched with a new
untitled document. You'll see the rest of the slide in the background.
It can't be edited here, but you can use it to help you position the
Auto Animate effect.

Creating a Zoom
Text effect

When it first displays, the Studio screen may contain one or more
windows in addition to the background for the second slide.
Depending on whether someone else has left Studio windows open,
there may be several windows visible on your screen.
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Tempo control
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Fig. 4.9 The Studio screen showing an Untitled document

To clear the screen for the tutorial,
1. I f  necessary, open the Panel window and close all the other

windows.
As in Overview, you use the Window menu to open and close
windows. The Studio Panel is very similar to the Overview Panel
window. In addition to the Rewind, Back , Stop, Step, Play, and
Loop buttons you are familiar with, it contains some additional
features.

Channel indicator

Frame counter

Fig. 4.10 The Studio Panel window

The background control changes the color of the Stage. On a black
and white Macintosh, it toggles between black and white. On a color
Macintosh, click and hold down the mouse button to display a
palette so that you can set a background color. Simply clicking it
will toggle between black and white. The sound control turns the
sound on and off. The tempo control provides control over the
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speed at which any animated movie plays. The frame counter
specifies exactly where in a movie you are.
The channel indicator shows which channels are being used at any
time. Each Director movie offers 24 separate channels that can
contain animated images. This allows you to control 24 separate
images on the screen at the same time, if you ever need that many.
For complete information about these controls, see the MacroMind
Director Studio Manual.

Repetitions: Speed: slow 20 fast

0  once m a n y Initial Delay: short long

0 E on tinuous, (RI? Timer Full-Size Duration: short long

2. Choose  Auto Animate from the Edit menu.
MacroMind Director displays the familiar Auto Animate dialog box.
You are going to create some zoom text.
3. S e l e c t  Zoom Text and then click OK.
MacroMind Director displays the Zoom Text dialog box.

Zoom Tenet

Zoom Teat

Abc Test Style... Zoom Type: Zoom in

Preuiew... Cancel ) OK

Fig. 4.11 The Zoom Text dialog box

The Zoom Text dialog box works exactly the same here as it does in
the Overview portion of the program. The Studio Auto Animate
dialog boxes have only slight differences from the Overview
versions. Here, for example, "Continuous, Use Timer" is disabled
because a Director movie must have a finite length.
Your text will be "Demand is Peaking."
4. T y p e  "Demand is Peaking" in place of "Zoom Text."
5. S e t  the "Full-Size Duration" to 5 seconds.
This will leave the text on the screen for 5 seconds.
6. C h a n g e  the Text style to Helvetica, plain, 18 points.
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If you don't have Helvetica, make sure the text is Geneva, plain, 18
points.
Leave the Repetitions set to 1. And leave the "Zoom Type" set to
"Zoom in."
By the way You must finish all your changes before you click OK.
Once you have created an Auto Animate effect in Studio, you can
modify it only with the Studio tools. You can't return to Auto
Animate to change it.
7. C l i c k  Preview.
You can set the start location of your text using the Preview screen.
8. C l i c k  the start location for the Zoom Text in the Preview screen.
You want the text to end just below the line of the graph.
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Fig. 4.12 Positioning the text below the line of the graph

9. C l i c k  OK to return to the Zoom Text dialog box, then click OK to
return to the Stage.

MacroMind Director displays the first frame of your zoom text on
the Stage. The Studio Stage window is similar to the Stage in
Overview, and it is where all your Director movies are displayed.
10. Tu r n  off Loop, click Rewind, and then click Play in the Panel window.

SlOpOini U rz.

Chapter  4: A d v a n c e d  Overview Tutorial 8 1



MacroMind Director plays your animated Zoom Text through.
When it finishes, notice the number in the frame counter of the
Panel. This number shows exactly how many frames your Auto
Animate effect has taken.
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Fig. 4.13 Your final Zoom Text effect

So far, everything is pretty familiar. You will now see how to use
some of the Studio tools to modify the Zoom Text.

The Studio portion of MacroMind Director is made up of several
interrelated windows. In this section you will use two windows to
make changes in your Zoom Text.
1. Choose  Cast from the Window menu.
MacroMind Director displays the Cast window. The Zoom Text you
have created is a single castmember.
Each individual graphic object or piece of text is called a
castmember, and can be controlled individually. You can have up to
512 castmembers. Auto Animate has created this castmember
automatically. You can add castmembers through the Clipboard, by
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importing files from other programs, or by creating text and graphic
elements within the Studio.

RE U n t i t l e d  Cast 0 2 1 3 1 4 1 5 1 6 1 7 1 8 1 g
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Fig. 4.14 The Cast window showing the castmember

Your Zoom Text has just one castmember. You will modify it in the
Paint window. The Zoom Text castmember is already selected in the
Cast window.
2. Choose  Paint from the Window menu.
MacroMind Director displays the Paint window that contains the
text you created.
The Studio Paint window is a sophisticated color and black and
white paint program. You use the Paint window to create and
modify castmembers. In this tutorial you will use only a few of the
many features available to create graphic images of high quality. For
complete information, see the MacroMind Director Studio Manual.
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Fig. 4.15 The Studio Paint window

You have decided to surround the Zoom Text with a rectangular
frame.
3. C l i c k  the second line width from the top in the line thickness

selector.

This line is 1 pixel wide.
When you are ready to draw the rectangle,
4. U s e  the rectangle tool to draw a rectangle around the text.

Be sure to select the hollow side of the rectangle tool, the side that
has no fill pattern. I f  you use the shaded side of the rectangle tool,
the rectangle you draw is filled with the current pattern.
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Fig. 4.16 Drawing a rectangle around the text

Your rectangle should be only slightly larger than the text. I f  you
make a mistake, or want to draw the rectangle again for any reason,
simply choose Undo from the Edit menu.
You can now return to the Cast and Stage windows to see the results
of your work.
5. C l i c k  the close box of the Paint window.
MacroMind Director closes the Paint window and displays the Cast,
Panel, and Stage windows. The text has changed in both the Cast
and the Stage to reflect your changes.
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Fig. 4.17 Modified Zoom Text shows in the Cast and Stage
6. C l i c k  Rewind, and then click Play in the Panel window.
MacroMind Director plays the animated Zoom Text effect. This time
the text that zooms is surrounded by the rectangle you added in the
Paint window.
Note I f  you inadvertently draw too large a rectangle, your text may
look squashed and unattractive. This occurs because the Auto
Animate effect establishes a certain amount of space to be used, and
the rectangle takes some of it.
To remedy this, return to the Paint window and redraw your
rectangle as close as possible to the text. Or you can create new text
in the Paint window using a smaller font size.

The Auto Animate effect you have created and modified is actually
an entire Director movie. In  this short section you will see how such
movies can be used in the Overview window.
In order to use your Zoom Text movie, you must first save it, then go
to the Overview window.
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Summary

1. S a v e  the Zoom Text as "Peaking."
To save the Zoom Text, choose Save as from the File menu, enter the
filename you want to use, then click the Save button.
Now you can return to Overview.
2. Choose  To Overview from the File menu.
Because you started Studio from Overview, when you go back,
MacroMind Director closes Studio and opens the Overview window
just as you left it.
MacroMind Director displays the Partial Bamboo 2 presentation you
have been working on. The Director movie has been added to it.
You can double-check the location of your Director movie overlay.
3. Adjust  the location of the Director movie overlay with Get Info.
Click the number above the slide you are working on to display the
slide With the overlay. Use the Get Info command to reposition the
overlay as needed.

Wrapping Up
It's time to enjoy the fruits of your labor.
1. Rewind the presentation, then play it.
The completed Partial Bamboo 2 slide show is displayed on the
screen.
When you leave Overview you can either save or discard the
changes you have made, depending on whether you want the final
version or not.

In this chapter you have learned to select different slides by moving
the playback head. You have duplicated clip animation, positioned
it carefully, and added a delay so that it appears when you want it
to. You have added sounds to your presentation.
You have used Launch Editor to open MacPaint from within
Overview. And you have gotten a taste of the Studio portion of
MacroMind Director, by making an Auto Animate Zoom Text and
then modifying it for use in your Overview presentation.
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To learn more about
Overview

Although this is the end of the Overview tutorials, there are
advanced topics in Chapter 5: Using Overview that you can read to
extend your command of the Overview tools. For tips on organizing
documents in Overview, read Quickly creating an Overview document
and Gathering documents.
For tips on editing Overview documents, browse through the
Working With Documents section. You'll find tips about timing and
position options, and launching a number of applications from
Overview for editing documents.

The next step
If you are working through all the tutorials, skip ahead to the
MacroMind Director Studio tutorials at the beginning of the
MacroMind Director Studio Manual. You'll learn about basic
animation techniques, titling tricks, and color effects. The tutorials
are designed to build upon material learned in earlier tutorials, so
work through the tutorials in sequence.
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Overview is the part of MacroMind Director used to
create multimedia slide presentations. In Overview, you
build presentations using graphic images, text, movies,
visual transitions, timing, and sound.
An Overview presentation or document is actually a
collection of documents from other applications
combined with effects like timers, transitions, or sounds
in Overview. When you organize these documents in the
Overview window the result is an Overview document.
This chapter will show you how to use the tools in
Overview to create a presentation.

5
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The Overview Window and Overview
Documents
The Overview window displays all of the documents and effects that
make up an Overview presentation. You can include MacPaint,
PICT, Glue, MacroMind Director, MacroMind Accelerator, and
Overview documents, as well as Auto Animates. You can use
sounds, timers, and transitions for different effects. When you play
an Overview presentation, it opens the documents and adds the
effects in the order you choose.
Here are the icons and the documents and effects they represent.

_■  U n t i t l e d  Oueruiew
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Glue document

PICT document

Paint document

MacroMind Director
movie

MacroMind Accelerator
movie

Auto Animate

Sound

Timer

Transition

Overview document

Fig. 5.1 The Overview window

You work with the Overview window by dragging document and
effects icons into the working area. They are automatically linked
together into a sequence. When you play the presentation, they are
activated in order, from left to right.
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Controlling an Overview Document
Controlling an Overview document includes starting and stopping a
presentation, stepping forward or backward slide-by-slide,
rewinding to the beginning, and looping continuously. You can
control your presentation with the Panel, the keyboard, or the
commands in the Control menu.

Playing an
Overview document

Stopping an
Overview document

Pausing an
Overview document

To play an Overview document,
1. I f  the Panel is not visible, choose Panel from the Window menu.
2. C l i c k  the Play button, or choose Play from the Control menu.
You can also press Enter on the numeric keypad.
You can use the Spacebar to resume playing an Overview document
if you previously used the Spacebar to pause the presentation.
Note Overview is designed to play non-interactive Studio movies.
If you play interactive movies from Overview, all interactivity is
ignored.

To stop an Overview document,
1. I f  the Panel is not visible, choose Panel from the Window menu.
2. C l i c k  the Stop button, or choose Stop from the Control menu.
You can also press 2, 5, or the period (.) on the numeric keypad.

You can pause an Overview document while it is playing. Pausing
stops the document until you resume.
To pause an Overview document,
1. Press the Spacebar.
To resume playing an Overview document after a pause,
2. Press the Spacebar again.

5
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Rewinding an
Overview document

Rewinding returns an Overview document to the first slide, ready to
play the presentation from the beginning.
To rewind an Overview document,
1. I f  the Panel is not visible, choose Panel from the Window menu.
2. C l i c k  the Rewind button, or choose Rewind from the Control menu.

You can also press 0 on the numeric keypad.

Stepping through an
Overview document

Stepping through an Overview document is a great way to proceed
through a presentation at your own pace. I t  is also very useful to
check on slides without having to wait for them to play all the way
through.
The document can be playing or stopped. I f  it is playing, it
continues playing as you step through it. I f  it is stopped, it remains
stopped as you step through it.
To step through an Overview document slide-by-slide,
1. I f  the Panel is not visible, choose Panel from the Window menu.
2. C l i c k  the Step button, choose Step from the Control menu, or click

anywhere in the Stage.

You can also press 3 or 6 on the numeric keypad.
Back stepping
through an
Overview document

Back stepping through a document lets you return to the previous
slides. I t  works like stepping, except in reverse. The document can
be playing or stopped.
To step backward through an Overview document,
1. I f  the Panel is not visible, choose Panel from the Window menu.
2. C l i c k  the Back button, or choose Back Step from the Control menu.

You can also press 1 or 4 on the numeric keypad.
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Replaying the
current slide

Step and Back change the current slide to the next or previous slide.
If you want to play the current slide again, you can do so. Like Step
and Back , replaying works whether the document is playing or
stopped.
To replay the current slide,
1. H o l d  down the Shift key and click Step.

Jumping to a
specific slide

Looping an
Overview document

You often need to move to a specific slide that is not the next or
previous slide. To do so you use the playback head, the box that
travels at the top of each column.
The playback head controls and indicates which column is the
current slide.
To move the playback head,
1. C l i c k  the number or letter at the top of the column of icons.
The playback head appears at the top of the column and the slide
appears on the Stage.

Looping affects the playing of an Overview document. When
looping is turned on, the document repeats until you stop it or turn
looping off. When looping is turned off, the document plays only
once. You control looping with the Loop button in the Panel.
To change looping,
1. I f  the Panel is not open, choose Panel from the Window menu.
2. C l i c k  the Loop button.
When the Loop button is selected (black), looping is turned on.
When it is deselected (white), looping is turned off.
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Organizing Documents in Overview
Documents in the Overview window are organized in columns.
Each column represents a slide of the presentation. When the
presentation moves forward from one scene to the next it is really
opening the next column of documents. When you arrange the
document icons in the Overview window in columns from left to
right, you are determining the order of the slides in your
presentation.

Background and
foreground

Each document in a column can be thought of as a layer in an
overlay. When you place a document below another in a column
you are adding a layer to the overlay. Therefore, if you want an
object to appear in front of another, place it lower in the column.

Background

17
Chart 1

Chart 2

Background

Foreground

Chart 3

Fig. 5.2 Documents assume foreground priority when placed lower in a column

For example, you may want a title you've created in Studio to fly
across the Stage in front of a Paint image. Since the Paint image is a
background layer, it should be at the top of the icons in that column.
The Director movie icon must be beneath the Paint icon in the same
column.
A typical Overview presentation might be built in this order:
1. D r a g  documents from the icon bar to the top (background)

position.
2. A d d  timers to control the timing of the slides.
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Adding documents
to Overview
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3. A d d  Director movie documents below any slide (or movie) for
annotation or clip animation.

4. A d d  sound below any slide or movie.
5. Choose Get Info for each document to fine-tune the presentation.
6. A d d  transitions between slides and movies.
You can always rearrange documents in the window by dragging
them to another position.
' *  Tips & Hints MacPaint, PICT, and Glue documents can be placed
in the foreground or background. MacroMind Accelerator
documents must be alone in a column.

When you open the Overview window you see an icon bar across
the top of the window. The icons displayed there represent the
kinds of documents and effects you can add to your presentation.
The document types from left to right are MacPaint, PICT, Glue,
MacroMind Director movie, MacroMind Accelerator movie, Auto
Animate, and Overview. The types of effects are sound, timer, and
transition.

ND Sales Meeting Overview

M  5

Intro 1

5

/
Forecast

•O'

Fig. 5.3 An Overview presentation with movies, slides, a transition, a timer,
and sound
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To add a document,
1. D r a g  a document icon from the icon bar to the Overview window

working area.
A dialog box appears.
2. S e l e c t  the document you want to add to your presentation.
3. C l i c k  Open.
The document is now part of the Overview presentation you are
creating. You'll be able to see it when you play the Overview
document.
If you want to include a document from an application that doesn't
save in MacPaint or PICT format, use Glue or SuperGlue- (from
Solutions, Inc.). Glue and SuperGlue are applications that save
documents from any application in a format that Overview can
display.

Limits on the
amount of
animation

There is a limit to the amount of animation you can use in a column
of documents. In practice, the limit is never a problem unless you
are adding many Director clip animations to a slide. I f  you add too
many, the ones at the very bottom of the column will not play.
The limit is related to the number of animation "channels" available
at any one time. The total number of channels used by all the
documents in one column cannot exceed twenty four. For more
information on the Panel's channel indicator see Chapter 6: Studio
Reference in the MacroMind Director Studio Manual.
To find out how many channels a movie or clip animation occupies,
use Launch Editor to open the Director movie document and look at
the channel indicator in the Studio Panel.

Selecting documents
in the Overview
window

You often need to select a document. You select a document before
you work with it, print it, or move it.
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Rearranging
documents

To select a document,
1. C l i c k  the document icon.
MacroMind Director highlights the selected document.
You can select more than one document. When you want to move a
group or column of documents, you first select the documents you
want, then you drag them as a group.
To select all the documents in a column,
2. S e l e c t  the top document in the column.
3. Sh i f t -click the last document.
All documents in between the two are selected.
There is another way to select a column of documents.
4. Command-click the last document in the column.
All the documents in the column are selected.
There is a way to select groups of documents, whether within one
column, or across columns. You can use the selection rectangle.
5. Position the pointer above and to the left of the first document, drag

diagonally across the documents and release the mouse button.
All the documents surrounded or touched by the rectangle are
selected. I f  your rectangle includes more than one column,
additional documents may be selected as well.

You may need to rearrange documents, or whole columns of
documents. You can move single documents between columns, or
within a column. You can add groups of documents to columns.
You can even move groups of columns.
To relocate a single document,
1. D r a g  it to a new location.
The window automatically scrolls when you reach the edge.
To move a group of selected documents,
2. D r a g  the group to the new location.
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Using Cut, Copy,
and Paste in the
Overview window

You can also cut, copy, and paste selected documents. This allows
you to delete documents, copy them, or move them easily when
dragging is awkward.
To cut, copy, or paste,
1. S e l e c t  a document, or group of documents, in the Overview

window.
2. Choose  the Cut or Copy command from the Edit menu.
3. Choose  the Paste command from the Edit menu.
You can paste in between columns of documents by clicking the gray
line between the columns.
MacroMind Director attempts to paste the documents in the location
you specify. However, if the documents cannot be placed there (if
the new column contains two Accelerator documents, for example),
the documents are placed as near as possible to the selected location.

Quickly creating an
Overview document

You can place all the documents in one folder into the Overview
window by using Quick Create. You can then rearrange the icons
into the order you want for your presentation.
Using Quick Create saves you the time of opening each document
separately.
To use Quick Create,
1. Choose  Quick Create from the Edit menu.
A dialog box appears.
2. C l i c k  Continue.
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Gathering
documents

Quick Create adds all the documents
within a folder to your Oueruiew.
After you click continue, select any
document in the folder of your choice.

Cancel

I
Continue

Fig. 5.4 The Quick Create dialog box

The directory dialog box appears.
3. O p e n  any document.
All the documents in the folder that have a file format that Overview
can use are placed in the Overview window. The icons appear in a
row across the Overview working area.

The Overview document you create contains names and locations of
documents, which can be in any folder on any disk. You can use the
Gather Documents command to move all the documents used by the
Overview presentation into one folder. This makes it easy to copy
your presentation all at once, rather than searching for individual
files.
To gather documents,
1. C r e a t e  your presentation.
2. S a v e  the Overview document.
3. Choose  Gather Documents from the Edit menu.
Gather Documents moves all the documents into the same folder as
the Overview document. The documents must all be on the same
disk. Gather Documents cannot move documents that are on
different disks.
Gather Documents moves documents only on one disk. I t  does not
move a document from one disk to another.
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Working With Documents
You can use the editing tools in Overview to fine tune the documents
in your presentation. You can adjust the position of the document
on the Stage so that it appears in exactly the right place. You can
delay its appearance until just the right time. In some cases you
need to go back to the application that created a document to change
the art or text.
You use the Get Info command to reposition and delay the
appearance of a document in a slide. You use the Launch Editor
command to launch the application that created a selected document
so that you can modify it.

Opening the Get
Info window for a
document

Every document you use in an Overview presentation has its own
Get Info window that you can use to change the position and timing
of the document. The Get Info window is different for different
types of documents. But the procedure for opening it is always the
same, regardless of the kind of document.
To open a document's Get Info window,
1. S e l e c t  the document in the Overview window.
2. Choose  Get Info from the Edit Menu.
MacroMind Director displays the Get Info window for the selected
document.
Or,
3. Double-click the document in the Overview window.
Double-clicking the document is a shortcut for selecting the
document and choosing Get Info from the Edit menu.

Repositioning
MacPaint, PICT,
and Glue documents

You often need to reposition a document on the Stage so that it lines
up with other elements on the screen. You can adjust the position
with the mouse.
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To reposition a MacPaint, PICT, or Glue document on the Stage,
1. O p e n  the Get Info window for the document.

Get Info
Info about: Bamboo Logo

Start after: 10 s e c o n d s
❑  Matte

Delaying the
appearance of a
MacPaint, PICT, or
Glue document

Drag Image On Stage Using Mouse.

Center Cancel OK

Fig. 5.5 The Get Info window for a MacPaint document

The mouse pointer changes to a hand when it is positioned on the
Stage.
2. D r a g  the document to the desired position with the hand.

If you want to center the document on the Stage,
3. C l i c k  the Center button.

You can only use one page of a multipage Glue document at a time.
Type the page number you want to use into the "Show Page
Number" box.

lot Tips & Hints Yo u  can also select and move the graphic on the
Stage. Click the graphic to select it; drag it to move it.

You occasionally want to delay the appearance of a document. For
example, you can start the slide with a piece of clip animation and
have the background appear after a few seconds.
To delay the appearance of a document,
1. O p e n  the Get Info window for the document.
2. T y p e  the number of seconds in the "Start after" box.
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The document delays appearing on the Stage for the number of
seconds you typed in the "Start after" box.

Repositioning a
Director movie

You can reposition a Director movie so that it aligns with other
elements on the screen such as the background or another Director
movie.
The location of the upper left corner of the image in the Director
movie depends on the way it is constructed in Studio. For
information about the startup location, see the Chapter 2: Clip
Animation Tutorial in the MacroMind Director Studio Manual.
To reposition a Director movie ,
1. O p e n  the Get Info window for the Director movie document.

 G e t  Info
Info About: Left Arrow

Timing: C) Use Movie's Normal Length
0  Use Current Timer Length
Repeat Movie: 1  T i m e s

Start After: 0  S e c o n d s

Position: C) Use Movie's Start Location
Q  Set Start Location With Mouse

Horiz: 0  V e r t i c a l : 0

❑  Before Movie Starts, First Image Appears
Z  After Movie Ends, Last Image Remains
El Play Movie's Sounds

Cancel OK

Fig. 5.6 The Get Info window for a Director movie

The mouse pointer changes to a crosshair when positioned on the
Stage.
2. C l i c k  the crosshair on the Stage to position the animation.

Or,
3. T y p e  the coordinates of the animation in the Horiz and Vertical

boxes.
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This is the start location for the animation.

II* Tips & Hints Yo u  can also select and move the movie on the
Stage. Click one of the movie's castmembers on the Stage to select
the entire movie. Dragging the selected castmember moves all the
movie's castmembers as a unit.

Controlling the
length of a Director
movie

When you place a Director movie document in a column, the length
of the movie controls the duration of the slide. In certain cases you
want a timer for the column to control the length of time the slide is
shown.
For example, if the Director movie is very short (perhaps even a
single frame), you can display it for a longer time. Or if the movie is
too long, you can show only the beginning.
To control the length of a movie,
1. O p e n  the Get Info window for the Director movie document.
"Use Movie's Normal Length" is the standard setting. "Use Movie's
Normal Length" overrides any current timer for the slide, and plays
the movie for the length of the animation. When this option is
selected, the letter M appears above the slide in the Overview
window to indicate that the Director movie is controlling the timing.
The whole slide is governed by the length of the longest movie.
To change the control to the current timer,
2. C l i c k  "Use Current Timer Length."
"Use Current Timer Length" forces the Director movie to play for
the length of the current timer for the slide. I f  the timer is shorter
than the movie, the movie is cut off. I f  the timer is longer than the
movie, the last frame remains on the screen.
To return control to the Director movie,
3. C l i c k  "Use Movie's Normal Length."
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Repeating a
Director movie

You can repeat a Director movie several times for special effects or
emphasis. For example, you might use a bit of clip animation to fly
an arrow to a significant place in the image. I f  your image is to
remain in place for some time, you might want the arrow to fly in
again and again to drive home the importance of what it points to.
To repeat a Director movie,
1. O p e n  the Get Info window for the Director movie document.
2. T y p e  the number of times you want to play the movie in the "Repeat

Movie" box.
If "Use Current Timer Length" is selected, make sure the timer is as
long or longer than the time it takes the movie to repeat.

Delaying a Director
movie

You can delay the appearance of a Director movie. This is useful
when you want an animated image to enter a slide after some
seconds. You can delay the start of several Director movies for
different lengths of time when you need to coordinate their
appearance on the screen.
To delay the appearance of a Director movie,
1. O p e n  the Get Info window for the Director movie document.
2. Ty p e  the number of seconds in the "Start After" box.
The Director movie is delayed for the number of seconds you typed.
If "Use Current Timer Length" is selected, make sure the current
timer is set for a longer interval than the "Start After" delay so you
can see the movie.
"* Tips & Hints You can set the first frame to appear when the slide
begins playing, and delay only the animation. This makes it possible
for part of an image to "come to life." See Holding the first or last
frame of a Director movie, later in this chapter.
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Controlling a
Director movie's
sound

Holding the first or
last frame of a
Director movie

You sometimes want to turn off the sound in a Director movie. You
would do so, for example, if the movie's sound was inappropriate
for a particular presentation.
To control the sound in a Director movie,
1. O p e n  the Get Info window for the Director movie document.
"Play Movie's Sounds" is the standard setting. The movie plays the
sounds indicated in its Score.
If you want to turn off the movie's sounds,
2. C l i c k  "Play Movie's Sounds."
This deselects the check box. For more information see Adding
sounds later in this chapter.
To return control to the Director movie,
3. C l i c k  "Play Movie's Sounds" again.
MacroMind Director places a mark in the check box to indicate that
"Play Movie's Sounds" is selected.
" l ips  & Hints I f  "Play Movie's Sounds" is selected and no sounds
are played, the movie may not use any sound, or the movie's Sounds
file may not be in the same folder as the movie.

You can display the first frame of a movie while the start of the
animation is delayed. And you can hold the last frame of a movie
until the presentation moves to the next slide.
These options allow you to achieve wonderful effects. By delaying
the beginning of animation, a static image can "come to life." By
holding the last frame, an animated image can "freeze." Such effects
can have a powerful impact.
To hold the first frame of a movie,
1. O p e n  the Get Info window for the Director movie document.
2. Se lec t  "Before Movie Starts, First Image Appears."
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3. E n t e r  a number in the "Start After" box to delay the animation.
The first frame of the movie appears when the slide is played. The
animation starts when the "Start After" delay expires.
To hold the last frame of a movie,
4. O p e n  the Get Info window for the Director movie document.
5. S e l e c t  "After Movie Ends, Last Image Remains."
The last frame of the movie remains on the Stage until the
presentation moves to the next slide. The "After Movie Ends, Last
Image Remains" check box is selected as the default setting.

Playing an
Accelerator movie

MacroMind Accelerator movies tend to be larger than Director
movies. Occasionally, Accelerator documents are so large that they
can't fit into memory. You have three options when there is not
enough memory available to play an Accelerator document.
To manage your computer's memory while playing an Accelerator
document,
1. O p e n  the Get Info window for the Accelerator document.
2. S e l e c t  "Play Only What Fits Into Memory."
This option plays as much of an Accelerator document as can be fit
into memory. After the document has played, the presentation
moves to the next slide.
Or,
3. S e l e c t  "Play Frame-By-Frame From Disk."
This option plays an Accelerator document one frame at a time. It's
slower than playing the Accelerator document at regular speed, but
all of the document will play.
Or,
4. S e l e c t  "Play In Chunks From Disk."
This option loads as much of the Accelerator document as possible in
memory, plays it, then loads the next chunk. The document will
play at accelerated speed but will pause as more chunks are brought
into your computer's memory.
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Controlling the
length of an
Accelerator movie

When you place a MacroMind Accelerator document in a column,
the length of the movie controls the duration of the slide. In certain
cases you want a timer for the column to control the length of time
the slide is shown.

Repeating an
Accelerator movie

For example, if the Accelerator document is very short (perhaps even
a single frame), you can display it for a longer time. Or if the movie
is too long, you can show only the beginning.
To control the length of a movie,
1. O p e n  the Get Info window for the document.
"Use Movie's Normal Length" is the standard setting. "Use Movie's
Normal Length" overrides any current timer for the slide, and plays
the movie for the length of the animation. When this option is
selected, the letter M appears above the slide in the Overview
window to indicate that the Accelerator document is controlling the
timing.
To change the control to the current timer,
2. C l i c k  "Use Current Timer Length."
"Use Current Timer Length" forces the Accelerator movie to play for
the length of the current timer for the slide. I f  the timer is shorter
than the movie, the movie is cut off. I f  the timer is longer than the
movie, the last frame remains on the screen.
To return control to the Accelerator document,
3. C l i c k  "Use Movie's Normal Length."

You can repeat a Director Accelerator movie several times for special
effects or emphasis.
To repeat an Accelerator document,
1. O p e n  the Get Info window for the document.
2. Ty p e  the number of times you want to play the movie in the "Repeat

Movie" box.
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If "Use Current Timer Length" is selected, make sure the timer is as
long or longer than the time it takes the movie to repeat.

Playing an
Accelerator movie's
sound

You sometimes want to turn off the sound in a Director Accelerator
movie. You would do so, for example, if the movie's sound was
inappropriate for a particular presentation.
To control the sound in an Accelerator document,
1. O p e n  the Get Info window for the document.
"Play Movie's Sounds" is the standard setting. The movie plays the
sounds indicated in its Score.
If you want to turn off the movie's sounds,
2. C l i c k  "Play Movie's Sounds."
This deselects the check box. For more information see Adding
Sounds later in this chapter.
To return control to the Accelerator document,
3. C l i c k  "Play Movie's Sounds" again.
MacroMind Director places a mark in the check box to indicate that
"Play Movie's Sounds" is selected.
iii. Tips & Hints I f  "Play Movie's Sounds" is selected and no sounds
are played, the movie may not use any sound, or the movie's Sounds
file may not be in the same folder as the movie.

Launching an
application to edit a
document

You may occasionally need to return to the application that created a
document to modify the image. You might want to reposition part
of the document, or change text or graphics.
MacroMind Director makes it possible to launch a document's
application from within the program, then return immediately to
Overview when you are finished editing the document.
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To launch the application that created a document,
1. S e l e c t  the document in the Overview window.
2. Choose  Launch Editor from the File menu.
The application starts up if it is on your hard disk. I f  the application
is not on your hard disk, insert the application's disk in the
Macintosh's disk drive.

Creating a Director
movie overlay

You can launch applications other than the one that created your
document. This comes in handy if you prefer using SuperPaint to
using MacPaint, for example. You can use SuperPaint as long as you
save your documents in the MacPaint or PICT format. Overview
cannot read documents created with SuperPaint and saved in the
SuperPaint format.
To specify a different application than the one that created the
selected document,
3. Choose  Preferences from the Control menu.
The Preferences dialog box appears.
4. C l i c k  the More Preferences button at the bottom of the dialog box.
The More Preferences dialog box appears. Use the boxes in this
dialog box to set the applications you want Launch Editor to start for
MacPaint and PICT documents.
Click the application name box to get the directory dialog box
showing applications on your hard disk. Select the one you want to
work with your MacPaint or PICT documents.
When you have finished editing the document, you can return to
Overview. Be sure to save the revised document first.
To return to Overview,
5. Q u i t  the application you were using.
You are returned to Overview.

Once you've built a slide in the Overview window, you can add to
your slide by creating a Director movie overlay. For example, you
might want to add a customized arrow flying across the screen.
Overview lets you create a Director document and return without
losing the Overview document.
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To create an overlay,
1. D r a g  a Director movie icon from the icon bar to the bottom of the

column of the slide you want to overlay.
The directory dialog box appears.
2. C l i c k  New.
A dialog box appears and asks you to save changes for the Overview
document.
3. C l i c k  Save.
MacroMind Director saves the Overview document and opens
Studio with a new untitled document. You'll see the rest of the slide
in the background. I t  can't be edited here, but you can use it to help
you position the overlay.
4. C r e a t e  your Director movie as you would any other.
Studio operates as it ordinarily does.
When you have finished creating the movie,
5. S a v e  your document, then choose To Overview from the File menu.
MacroMind Director returns you to Overview. The overlay is shown
as a Director document in the column.

Using an overlay to
add text to a slide

Very often you use an overlay to add a comment or other piece of
text to a slide. MacroMind Director makes it easy to create text with
no background to add to a slide.
To add text,
1. U s e  the overlay technique to go to Studio.
Creating an overlay is described in the preceding section.
When you have opened Studio,
2. Choose  Tool from the Window menu.
The Tool window appears.
3. C l i c k  the text tool in the Tool window.
Your pointer changes to a crosshair with the letter A next to it.
4. C r e a t e  a text box on the Stage.
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Printing an
Overview document

5. T y p e  the text, then click a blank area of the stage to deselect the
text.

The box becomes transparent.
To change the font, size, or style of the text,
6. C l i c k  the text on the Stage.
7. S e l e c t  the text by dragging across it.
8. Choose  a new font, size, or style from the Text menu.
Complete the overlay by saving the Director document and
returning to Overview.
Use the Get Info command to reposition the overlay as needed. See
Repositioning a Director movie earlier in this chapter for more
information about using the Get Info command.

Overview offers a variety of printing options so you can print
storyboards or handouts for your presentation. You can choose to
print all the slides in your presentation, a range of selected slides, or
a picture of the Overview window.
To print an Overview document,
1. Choose  Page Setup from the File menu.
The Page Setup dialog box gives you the opportunity to set the paper
size your printer is using, to change the orientation of the image on
the paper, to reduce or enlarge the image, and to set various printer
effects and options.
When you have finished,
2. C l i c k  OK.
3. Choose  Print from the File menu.
MacroMind Director displays the Overview Print Options dialog
box. Here you choose what to print.
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Overview Print Options...
0  Slides: 0  Overview Window

C) RH Slides
0  Selected Slides

Page Layout Cancel Print

Fig. 5.7 The Overview Print Options dialog box

4. S e l e c t  the option you want.
You can print all the slides, the slides you have previously selected,
or the Overview window.
5. C l i c k  Page Layout.
MacroMind Director displays the Page Layout dialog box.

Page Layout...

•  1 1

CI hi

E] Print Page Header (Filename and Date)
1:1Print Page Footer:

Frame Printing Options:
CI Sillyip 1: olumn I o mai
El Border Around Frame
❑  In( tusle ft•arne titifIlber
❑  Fr amP E omm P II t
El Registration Marks

ICance l

Scale:
C) 100%

50%
25%

OK

Fig. 5.8 The Page Layout dialog box

6. S e l e c t  the layout options you want to use.
Page Layout lets you print full-size (100%), 50%, or 25% reduction of
your slides. You can include the date, filename, frame number, and
your own footer in the printout.
The Page Layout panel provides a thumbnail version of the page as
it is affected by each selected option.
7. C l i c k  OK.
The Print Options dialog box returns to the screen.
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8. C l i c k  Print.
MacroMind Director displays a standard Macintosh printer dialog
box appropriate for the printer you are using.
9. C l i c k  OK.
Your printer prints your slide(s) or window according to your
instructions.

Printing the
Overview window

Printing
storyboards

Tips & Hints For information about the Page Setup or Printer
dialog boxes, see the manuals that came with your Macintosh and
your printer.
For a complete explanation of your options in the Print Options and
Page Layout dialog boxes, see Chapter 6: Overview Reference.

You may want to print out a copy of your Overview window so that
you can use it to check your work, to keep a record of the
presentation, or as a script while reviewing a presentation.
To print the Overview window,
1. Choose  Print from the File menu.
MacroMind Director displays the Print Options dialog box.
2. S e l e c t  "Overview Window" and then click Print.
MacroMind Director displays a standard Macintosh printer dialog
box appropriate for the printer you are using.
3. C l i c k  OK.
MacroMind Director prints the contents of the Overview window.

A storyboard is an outline of a presentation, in visual form. You
often use a storyboard as a presentation in itself to elicit ideas from
other people. You may need to show others a version of your
unfinished work for commentary or approval.
The printing options of MacroMind Director give you ample
flexibility to print storyboards for any Overview presentation.
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To print storyboards,
1. S e l e c t  the slides you want to print.
For information about selecting documents, see Selecting documents in
the Overview window, earlier in this chapter.
2. Choose  Print from the File menu.
3. S e l e c t  "Selected Slides."
4. C l i c k  Page Layout.
In the Page Layout dialog box, choose the options that provide the
printing layout you want for your storyboards. For example, you
can print at 100% scale for a full-size printed version of the slides
you have selected to print. You can then paste the printed images
onto large boards for your presentation.
If you print at 25% scale and use a single column format, you can
print several slides on a page with room to write comments.
In every case, the Page Layout panel provides a thumbnail version of
the way each page will look when printed.

Page Layout...
0  Print Page Header (Filename and Date)
❑  Print Page Footer:

Frame Printing Options:
Single Column Format

1:31 Border Around Frame
❑  lrn(lui1e l Fame Nlimber
❑  Frame 1: t
❑  Regis tr Um) Marks

Cancel

Fig. 5.9 The Page Layout options for storyboards

Scale:
0  1 00%
0  50%

25%

I O K  j
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Using Overview Effects

Adding a timer

Timer

Number of seconds

New timer changes time
for subsequent slides

The tools in Overview include effects you can add to polish your
presentation. You can add timers, transitions, or sounds. Timers set
the tempo of your Overview document. Transitions are visual
effects like wipes, dissolves, pushes and reveals that add a sense of
continuity and flow to your Overview document. Adding sounds to
an Overview presentation can draw your audiences' attention to
particularly important slides.
All of the effects are represented by icons in the Overview window
icon bar. You add them to your document by dragging an icon from
the icon bar into the working area of the Overview window.

Each slide in an Overview presentation is displayed on the screen in
the order its icon is placed in the Overview window. You use timers
to control the length of time a slide appears on the Stage.
Once you've set a timer, it controls the slides to the right of the
column in which it is set until it encounters a new timer. The current
time for each slide is displayed above the slide. Timers do not affect
the timing of transitions.
_❑ Sales Meeting Overview

4
IAN

Company Logo
CI E

4

Market Share

8

Conclusion

4

7a:

Fig. 5.10 Numbers above the documents show the time for each slide
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To add a timer,
1. D r a g  the timer icon from the icon bar to the Overview window.
2. P l a c e  the timer icon to the left of the column you want to time.

You may also position the timer beneath documents in a column to
save space in the window. The effect is the same as positioning it to
the left of the column.
3. T y p e  the number of seconds to set the timer.
4. C l i c k  anywhere in the Overview window or press Return.

10 Tips & Hints Timers do not normally affect the length of a Director
or Accelerator movie. For complete details about how a timer can
work with a movie, see Controlling the length of a Director movie and
Controlling the length of an Accelerator movie, earlier in this chapter.

Changing the time
in a timer

If you need to change the time a particular slide is displayed, you
can change the time in its timer.
To change the time,
1. S e l e c t  the number below the timer.
2. T y p e  the new number.
3. C l i c k  anywhere in the Overview window or press Return.

The new number now governs all the slides controlled by the timer.

Setting multiple
timers

Overview presentations can have any number of timers.
To set multiple timers,
1. D r a g  the first timer from the icon bar and place it in the column you

want to time.
2. T y p e  in the number of seconds you want to display the slide.
3. C l i c k  anywhere in the Overview window or press Return.
4. D r a g  a second timer from the icon bar and place it in the next

column you want to time.
5. T y p e  the number of seconds you want to display the second slide.
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6. C l i c k  anywhere in the Overview window or press Return.
7. R e p e a t  as necessary.
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Adding sounds

Sound icon

Sounds can add tremendous impact to your presentation. Overview
provides a variety of sounds that you can add to your presentation.
In order for the Sound menu to appear, and for the sounds you want
to be used in your presentation, you must have a Sounds file in the
same folder as MacroMind Director, the System file, or the Overview
document you are building.
To add sound,
1. D r a g  the sound icon from the icon bar and place it in the column in

which you want the sound to occur.
If there is more than one document in that column place it beneath
the last document.
2. Choose  a sound from the Sound menu.

Fig. 5.11 Sound icon in a slide

If a slide is displayed for a length of time that is less than the length
of the sound, the sound will be cut off. The solution is to set a timer
for the slide for as long as or longer than the sound effect you use.
You can only play one sound in a column. If  you assign a sound to a
slide that has a Director movie that plays a sound, Overview plays
the topmost sound in the column. See About the MacroMind Director
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Sounds file in the Sounds Utility section in Chapter 6: Studio Reference of
the MacroMind Director Studio Manual.
illo Tips & Hints The Sounds file can have any filename. You choose
the sounds file that you want Director to use in the Preferences
dialog box.
If there are no sounds in your Sound menu, you probably don't have
a Sounds file in the MacroMind Director folder, in the System folder,
or in the document folder.

Changing and
controlling sounds

You may need to change a sound to provide a more appropriate
sound for a particular slide.
For information about controlling the sounds included with a
Director or Accelerator movie, see the appropriate entries in Working
With Documents earlier in this chapter.
To change a sound,
1. S e l e c t  the sound icon in the Overview window.
2. Choose  a new sound from the Sound menu.
To control the sound in a document,
3. S o u n d  Is On must be selected in the Control menu to hear sounds.
Or,
4. C l i c k  "Play Movie's Sounds" in the Get Info window to turn a

particular Director movie's sounds on or off.
Or,
5. Choose  Control Panel from the Apple menu and increase or

decrease the Macintosh Speaker Volume.
Adding transitions

Transitions determine how one image changes to the next. You use
them to add motion and depth to your presentation.
Transitions are sometimes the spice you use to add flavor to a
presentation. And sometimes a transition is at the very heart of your
presentation. You can use transitions to move gracefully from one
slide to the next, giving your presentation a professional polish. Or
you can use a transition to simulate animation, as shown in the
Joining of the Rails tutorial.
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Transitions can be used to begin or end a presentation, or between
slides.
MacroMind Director offers several basic types of transitions. The
types include the following:
Wipe A  line wipes across the screen unveiling the second image as
it covers the first.
Push Both images move together. The first image pushes the second
image off the screen.
Reveal The first image moves away to reveal the second image
behind it.
Dissolve The first image dissolves, gradually exposing the second
image.
Strips The second image is unveiled in wide strips.
Cover The second image moves into place over the first image.
Each transition is illustrated next to its name in the Set Transition
dialog box.

Set Transition...

Strips on right, build down
Strips on right, build up
Strips on top, build left
Strips on top, build right

M  Venet ian Blinds
Vertical Blinds

o  Wipe  down
Wipe left

"III

 W i p e  r igh t
Wipe up

T i  Zoom close
I -7  Zoom open

Duration:
• 8 14>
in 1 /4 seconds

Chunk Size:
1‹:3
smooth

lE>
rough

C) 5tage area
0  f. hanging area

Cancel

I S e t  Transition

Fig. 5.12 The Set Transition dialog box

To set a transition,
1. D r a g  the transition icon from the icon bar to the Overview window.
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2. Posi t ion the icon between the two slides you want to affect.

The Set Transition dialog box appears containing an alphabetical list
of transitions.
3. S e l e c t  the transition from the list.
4. S e t  any of the transition controls you need to.
5. C l i c k  Set Transition.

Controlling
transitions

You usually need to set the Duration, but you can depend on the
Chunk Size settings to be optimal for the transition you select.
The Duration setting affects the amount of time, in quarters of a
second, over which the transition occurs. The Chunk Size setting
affects the number of pixels affected in each increment. The larger
the Chunk Size, the rougher the transition.
To change the Duration and Chunk Size settings,
1. U s e  the scroll bar to change the setting.

You can drag the scroll box, click the scroll bar, or click the arrows at
either end.

Changing a
transition

You will occasionally decide to substitute one transition for another.
You can return to the Set Transition dialog box to change the
transition.
To change a transition,
1. S e l e c t  the transition icon you want to change.
2. C h o o s e  Get Info from the Edit menu.

The Set Transition dialog box appears.
3. S e l e c t  the transition you want.
4. S e t  any of the transition controls you need to.
5. C l i c k  Set Transition.

in, Tips & Hints Double-clicking the transition icon is a shortcut for
selecting the icon and choosing the Get Info command.
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Auto Animate
Use Auto Animate to add titles, charts, and text effects to your
presentation. The Auto Animate effects are quick and effective
solutions to many text animation problems. Typically, effects that
would take an hour of work in Studio take a few minutes in Auto
Animate.
Auto Animate provides six different effects:
♦ Bu l l e t  Chart
♦ B a r  Chart
♦ Z o o m  Text
♦ Banner
♦ Credi ts
♦ Te x t  Effects
Each effect is animated: text moves, zooms in, out, or both, bars
grow on a bar chart, credits roll up the screen, and so on. A l l  Auto
Animate effects use text. The Bar Chart effect adds the capability of
calculating the scale and bar height from numeric values.
To choose an Auto Animate effect,
1. D r a g  the Auto Animate icon into the working area of the Overview

window.
MacroMind Director displays the Auto Animate dialog box.
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Working with
Auto Animate

Ruto Rnimate„.

iF_== C) Bullet Chart

Bar Chart

; A O  Zoom Text

4-ABCO Banner

Credits

- A -  0  Text Effects

Cancel ( O K

Fig. 5.13 The Auto Animate dialog box
2. S e l e c t  the effect you want to work with in the Auto Animate dialog

box.

When you click OK, the dialog box for your choice appears.

To work with any Auto Animate effect,
1. S e l e c t  the effect you want in the Auto Animate dialog box and click

OK.

The dialog box for that effect appears.
2. T y p e  in the text you want.
3. S e t  the font, size, and style.
4. A d j u s t  the Speed and other controls.
5. P r e v i e w  the effect.
6. C h a n g e  the start location if necessary.
7. R e t u r n  to the dialog box for further adjustments.
When your Auto Animate effect is satisfactory,
8. C l i c k  OK to return to the Overview window.
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The Auto Animate effect is shown as an icon in the Overview
window.

Untitled Overview

Changing an Auto
Animate document

00043
0

 M M  M   M   M   M

•  —
•  — —

taswees a d a r m s

Bullet Chart B a r  Chart

AI /
°"°':•"x•

Zoom Text B a n n e r  C r e d i t s  T e x t  Effects

A---,

\ A  `"."*".*I-ABC

C31

Fig. 5.14 The Auto Animate icons in the Overview window

You occasionally need to revise an Auto Animate effect, to change
the text or to reposition the effect.
To change an Auto Animate effect,
1. S e l e c t  the Auto Animate icon you want to change.
2. Choose  Get Info from the Edit menu.
MacroMind Director displays the dialog box for that Auto Animate
document. Make any changes you want, then,
3. C l i c k  OK.
A* lips & Hints Double-clicking the Auto Animate icon is a shortcut
for selecting the icon and choosing the Get Info command.
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Repositioning an
Auto Animate
document

You can change the position of any Auto Animate effect to place it
exactly in relation to other images on the screen.
To change the position of an Auto Animate effect,
1. S e l e c t  the Auto Animate icon you want to change.
2. Choose  Get Info from the Edit menu.
MacroMind Director displays the dialog box for that Auto Animate
document.
3. C l i c k  Preview.
MacroMind Director displays the Preview screen for that effect. You
can change the start location by clicking with the mouse.
Make any changes you want, then,
4. C l i c k  OK to return to the dialog box.
5. C l i c k  OK to return to the Overview window.

Using Auto Animate
in a compound slide

You can use any Auto Animate effect as the only element in a slide.
However, you very often combine an Auto Animate effect with other
documents in a compound slide.
You have seen how to use an animated bullet chart with a simple
MacPaint background in Chapter 2: Auto Animate Tutorial. The same
principle can be applied to many different effects. Zoom Text can
zoom in or out of a background, and a Banner or a Credits list can
scroll text in front of a background.
You can combine an Auto Animate effect with a Director movie as
well. Clip animation can work together with the Auto Animate
effect to provide extra movement and emphasis.
You can control the appearance of the Auto Animate effect using the
"Initial Delay" setting for each effect.
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Fig. 5.15 Combining effects

To combine an Auto Animate document with others in a compound
slide,
1. C r e a t e  the compound slide by dragging document icons.
2. R e p o s i t i o n  and change the timing of the Auto Animate effect and

the other documents so they work together.
3. P l a y  the slide to check on the result.
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Chapter 6: Overview Reference

Chapter 6 describes the menus and windows in
Overview. The menus described in this chapter are
organized as they appear from left to right in the menu
bar on your screen. The three Overview windows are
described in the order they appear in the Window menu.
To learn more about how a menu command, dialog box,
or window is used to create Overview presentations, see
Chapter 5: Using Overview. Chapter 5 presents step-by-
step instructions for performing specific tasks, much like
recipes in a cookbook. Consult both chapters when
you'd like to have more information on a procedure or
definition.
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111
About MIA Director...
Help...

Alarm Clock
Rrt Grabber I1'"
Calculator
Chooser
Control Panel
Find File
Key Caps
Scrapbook

The Apple Menu
The Apple menu is indicated by the 4 symbol at the left of the menu
bar.
The menu commands described in this section are: About MM
Director, Help, and the Art Grabber IF' desk accessory. For
information about using and installing desk accessories, see the
manual that came with your Macintosh.

About MM Director...
Choosing About MM Director displays a dialog box showing
you how much memory is available to Director for your document.
It also indicates how much memory different parts of the current
document use and the document's size on disk. I f  the document is
new and has never been saved, its file size is not displayed.

Help...
The Help command gives you quick access to useful information
about MacroMind Director menu commands, windows and dialog
boxes. There are two ways to use Help. Choosing Help from the
Apple menu opens the Help window. You can browse through the
contents of the Help window by using the Next and Previous
buttons to move through the text. The second way to use the Help
window is by pressing the Command and Option keys. When
Command-Option is pressed, the pointer becomes a question mark.
Choosing a menu command or clicking a window, dialog box, or
icon with the question mark opens a window of information about
the item in question.
The Help window becomes active when it is first chosen.
Subsequently, if you leave the window open on the screen, new text
displays in the Help window, but the window does not become
active. However, if you click a dialog box with the question mark
pointer, you must close the Help window before you can use the
dialog box.

Art Grabber II
Art Grabber II is a desk accessory for importing artwork from other
applications to MacroMind Director. You can find it in the Help &
Utilities folder. Install Art Grabber II in the Apple menu. For
information about installing desk accessories, refer to the
instructions that came with your computer.
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After Art Grabber II is installed, you can use it to copy images from
graphics applications without quitting the current application. You
can open and copy MacPaint files, castmembers from MacroMind
Director documents, Scrapbook files, or PICT files, and paste them
into the current application. Ar t  Grabber II converts all files to bit
mapped images, ready to paste into the Studio Paint or Cast
windows.
When you choose Art Grabber II from the Apple menu, the directory
dialog box and a dynamic menu called the Grabber menu appears at
the far right of the menu bar. See the section called Art Grabber II
Desk Accessory in the MacroMind Director Studio Manual for more
information on using Art Grabber II.

File
To Studio
New a g N
Open... N O

Saue
Save Rs...
Revert

aes

Launch Editor X L
Return to Overview

Page Setup...
Print...

Quit

The File Menu
The commands in the Overview File menu are used for managing
files, launching applications, and printing your presentations.

To Studio
The To Studio command closes the Overview document and opens a
new Director document.

New
The New command opens a new, untitled, Overview document. The
first time you save or quit you will be asked to type a name for the
document.
Overview can open only one document at a time, so if a document is
already open when you choose New, a dialog box appears, giving
you the opportunity to save or discard the latest changes.

Open...
The Open command lets you open an existing Director movie or
Overview document. When you choose Open, the directory dialog
box appears. Click the buttons at the bottom of the box to select
which type of document you want to display. Then select the
document and click Open.
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MacroMind Director 3.0
0  B&W Examples
0  Clip Media
Ci Color Euamples
O  Device Control
O  Feature [vamples
0  Fonts
O  Guided Tour
d  Help Fr Utilities
O  Player

Director 0  Overview 0  Both
❑  Convert Black 0' White Bitmaps To Color

(=Hard Disk

Eject

Drive

Open

Cancel

Fig. 6.1 The directory dialog box

The "Convert Black & White Bitmaps To Color" check box only
applies to Director movie documents. For complete information, see
the MacroMind Director Studio Manual.

Save
The Save command saves the current Overview document to disk.
The current version replaces any previous version on your disk. It's
a good idea to save often while you're working.

Save As...
Use the Save As command to save the current Overview document
to any disk. Click the Drive button to save to different disk drives.
You can also rename the document by typing the document's new
name in the text box.
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{n  MacroMind Director 3 0

CiBMW Examples
CI Clip Media

Color Examples
Device Control

CI Feature ['lamples
CI Fonts

Save Overview Hs:
Untitled

= H a r d  Disk

Eject

Drive

Save

Cancel

Fig. 6.2 The Save As dialog box

Revert
The Revert command returns the last saved version of the current
Overview document to the Stage, losing any changes made since the
document was saved.

Launch Editor
The Launch Editor command launches the application that created a
selected document in the Overview window and loads that
document so that you can edit it.
Quitting the launched application returns you to the current
Overview document. Launch Editor is very useful for working on
your Overview documents without quitting Overview.
You can set which application you want to launch for MacPaint and
PICT documents with the Preferences command in the Control
menu. For complete information, see the Preferences command in The
Control Menu in Chapter 6: Using Studio of the MacroMind Director
Studio Manual.

Return to Overview
The Return to Overview command is active only when you have
launched an Overview document to edit it. This command returns
you to the Overview document you were working with originally.

Page Setup...
The Page Setup command offers options for determining how a page
is to be printed. The Apple ImageWriter® provides page orientation,
page sizes, 50% reduction and other options. The Apple
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LaserWriter® also offers reduction/enlargement, smoothing, and
font substitution.
For complete information, see the manuals that came with your
Macintosh and your printer.

LaserWriter Page Setup 5.2

Paper: 0  US Letter
0  US Legal
Reduce or
Enlarge•

O  B4 Letter 0  Tabloid
0  B5 Letter

Printer Effects:
❑  Font Substitution?
❑  TeHt Smoothing?
❑  Graphics Smoothing?
❑  Faster Bitmap Printing?

100

Orientation

OK

Cancel

[Options

Help

Fig. 6.3 The Page Setup dialog box for the Apple LaserWriter

Print...
The Print command lets you print out your presentation. When you
choose Print from the File menu, the Overview Print Options dialog
box appears.
Use the radio buttons to print all the slides in your presentation, a
range of selected slides, or a picture of the Overview window. When
you print slides, one image is printed for each column. I f  there is an
animation in the column, the last frame is printed.

Overview Print Options...
C) Slides: 0  Overview Window

fill Slides
0  Selected Slides

Page Layout Cancel Print 3

Fig. 6.4 The Overview Print Options dialog box

The buttons at the bottom of the dialog box offer further printing
control. Click Print to print your choice.
Click Page Layout to print a header or footer on each page, or select
several Frame Printing Options. They include " Border Around
Frame," "Single Column Format," and "Registration Marks."
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Edit
Undo Overview 3 6 2

Cut Overview N H
Copy Overview N C
Paste Overview N U
Clear Overview
Select 1111

Get Info... 8 6 1
Quick Create...
Gather Documents...

Page Layout...
E  Print Page Header (Filename and Date)
❑  Print Page Footer:

Frame Printing Options:
Singip (Wilma orrrial

Z  Border Around Frame
El in( tulle 1, r a m  Numbpr

❑

Framp o rnmen t
Registration Marks

( Cancel

Scale:
C) 100%

50%
25%

OK

Fig. 6.5 The Overview Page Layout dialog box

You can scale your slides to 25%, 50%, or 100% with the radio
buttons.

Quit
Choosing Quit exits Overview and returns you to the Finder. When
you choose Quit, a dialog box asks you to save any changes made to
your current document. The Clipboard is automatically saved when
you quit, with its contents available for use in another program.

The Edit Menu
The Edit menu contains commands common to all Macintosh
applications. You use Edit commands to undo, cut, copy, paste,
clear, and select documents in the Overview window.
The Edit menu also has commands to position, gather, and quickly
create Overview presentations.

Undo
Undo reverses your last action. Since it works only on your last
action, you must use it right after a mistake, before making any other
changes to the presentation. Undo works with Overview editing
operations, such as moving icons, or dragging them out of the icon
bar. Undo undoes Cut Overview, Copy Overview, Paste Overview,
and Clear Overview. I t  does not work with File commands, such as
Open.
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Cut Overview
The Cut Overview command removes selected icons from the
Overview window's working area and places a copy of them in the
Clipboard.
Cut Overview can be used to delete selected icons or move them to
another location. Once you've cut them you can paste them to
another column or Overview document.

Copy Overview
The Copy Overview command copies selected icons from the
Overview window's working area to the Clipboard. Unlike the Cut
Overview command, Copy Overview does not remove the selected
icon from its original location. Use Copy Overview and Paste
Overview when you want to duplicate icons, rather than move them.

Paste Overview
The Paste Overview command pastes an icon from the Clipboard to
a selected location in the Overview window. To select a location to
paste in the Overview window, click that spot before choosing Paste
Overview. I f  you click the gray line between slides the icon is
inserted between two slides. I f  you select another icon, the icon that
is pasted replaces the selected icon.

Clear Overview
Clear Overview removes selected icons from the Overview window
without saving them to the Clipboard. Use Clear Overview when
you have no further use for the documents, and you do not want to
affect the contents of the Clipboard.

Select All
The Select All command selects all of the icons in the Overview
window's working area.

Get Info...
The Get Info window appears when you select a document or effect
in the Overview window's working area and choose Get Info from
the Edit menu or when you double-click the icon in the working
area. The options available to you will vary according to the type of
icon that is selected when you choose Get Info.
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Get Info
Info about: Company Logo

Start after:

❑  Matte

seconds

Drag I m a g e  On Stage Using Mouse.

Center Cancel i O K  )

Fig. 6.6 The MacPaint Get info dialog box

The Get Info window for MacPaint and PICT documents has several
purposes—setting the position, the delay, and the matte ink effect.
You can set the position of the document on the screen by dragging
the document, or by clicking the Center button. You can set a delay,
in seconds, after which the document appears by typing the number
in the "Start after" box.
The Matte check box lets you apply a matte ink effect to the image.
This is useful for foreground images; it has no effect on background
images.
For PICT documents, you can choose "Use PICT's palette." This
option lets you use the palette associated with the PICT document
instead of the current System palette. This can affect other
documents in the same slide.

Get Info

Info about: Glue Document

❑  Matte S t a r t  after:
Show Page Number:

lo
1

seconds
of 1

Drag I m a g e  On Stage Using Mouse.

Center Cancel OK

Fig. 6.7 The Glue Get Info window

The Glue Get Info window is similar to the MacPaint and PICT Get
Info window. The Matte check box lets you apply a matte ink effect
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to the image. This is useful for foreground images; it has no effect on
background images.
You can set the position and the delay for the selected Glue
document. In addition, you can type a page number in the "Show
Page Number" box. I f  your Glue document is a multiple page
document you can display a specific page on the Stage by typing the
page number in the "Show Page Number" box.

 G e t  Info
Info About: Conclusion

Timing: (D Use Movie's Normal Length
0  Use Current Timer Length
Repeat Movie: 1  T i m e s

Start After: 0  S e c o n d s

Position: C) Use Movie's Start Location
0  Set Start Location With Mouse
Horiz: 0  V e r t i c a l : 0

❑  Before Movie Starts, First Image Appears
[E] After Movie Ends, Last Image Remains
E  Play Movie's Sounds

Cancel OK )
Fig. 6.8 The Director movie Get Info window

Your choices in the Director movie Get Info window include Timing
options, Position options, and options to hold the first or last frame
of your movie. You can also turn the movie's sounds on or off.
Use Movie's Normal Length will play the entire length of the movie
regardless of any timers you may have set in the Overview window.
Use Current Timer Length will play the movie only for the length of
the current timer in the Overview window. I f  the timer is set for less
than the length of the movie, the movie will end before it has
finished playing. I f  the timer is set for more than the length of the
movie, the last frame of the movie remains until the slide is finished.
Repeat Movie will play the movie for the number of times you type
in the box. I f  you have the "Use Current Timer Length" option
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selected, make sure the timer is set for the length of time it takes
your movie to repeat.
Start After permits you to delay the start of the movie for a length of
time after Overview plays the column containing the movie.
Use Movie's Start Location will cause your movie to start in the same
location as it started in Studio.

 G e t  Info
Info Rbout: Rccelerated Mouie 1.mma

Timing: 0  Use Movie's Normal Length
0  Use Current Timer Length
Repeat Mouie:  1  Times

When Not Enough Memory To Load Movie:
C) Play Only What Fits Into Memory
0  Play Frame-By-Frame From Disk
0  Play In Chunks From Disk

▶14 Rfter Mouie Ends, Last Image Remains
i i  Play Movie's Sounds

Cancel O K

Set Start Location With Mouse allows you to set a new position to start
the movie. Position the pointer on the screen at the location you
prefer, and click. The movie begins at the point you clicked.
Horiz and Vertical allow you to offset the starting location for your
movie by typing values rather than by clicking. The numbers in the
boxes show you how far, in pixels, the document is offset.
Before Movie Starts, First Image Appears will display the first frame of
your movie before the animation begins if you set a delay for the
start of the movie.
After Movie Ends, Last Image Remains will display the last frame of
your movie until the presentation moves to the next column.
Play Movie's Sounds will play the sounds in your movie when the
movie's Sounds file is available to Overview. I f  this option is selected
and the sound still does not play, the Sounds file is probably not in
the proper folder.

Fig. 6.9 The Accelerator Get Info window
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When you choose Get Info about a selected Accelerator document
your options include:
Use Movie's Normal Length will play the entire length of the movie
regardless of any timers you may have set in the Overview window.
Use Current Timer Length will play the movie only for the length of
the current timer in the Overview window. I f  the timer is set for less
than the length of the movie, the movie will end before it has
finished playing.
Repeat Movie will play the movie for the number of times you type
in the box. I f  you have the "Use Current Timer Length" option
selected, make sure the timer is set for the length of time it takes
your movie to repeat.
If the Accelerator document requires more memory than is available,
you can choose from these options:
Play Only What Fits Into Memory will play as much of the Accelerator
document as can be fit in memory, then proceed to the next column
of icons.
Play Frame-By-Frame From Disk will play your Accelerator document
one frame at a time. It's slower than an accelerated document but all
of the document will play.
Play In Chunks From Disk will load as much of the Accelerator
document as possible in memory, play it, then pause as another
chunk of the document is loaded in memory. Al l  of the document
will be played at accelerated speed, but intermittent pauses will
occur as more chunks are accessed.
After Movie Ends, Last Image Remains will display the last frame of
your movie until the presentation moves to the next column.
Play Movie's Sounds will play the sounds in your movie when the
movie's Sounds file is available to Overview. I f  this option is selected
and the sound still does not play, the Sounds file is probably not in
the proper folder. For more information, see The Sound Menu later in
this chapter.
You cannot choose a new starting location or delay an Accelerator
document as you can with a Director movie.
You may also choose Get Info for a selected transition. When you
choose Get Info for a transition, the Set Transition dialog box
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appears. For more information about transitions, see Overview effects
later in this chapter.
You can also choose Get Info for a selected Auto Animate document.
When you choose Get Info for an Auto Animate document, the
dialog box for that effect is displayed. For more information about
Auto Animate, see Auto Animate later in this chapter.

Quick Create...
The Quick Create command takes all the documents in a folder and
places them in the Overview window. Quick Create will only take
documents in file formats that Overview can display, i.e., MacPaint,
PICT, Glue, MacroMind Director, Accelerator, and Overview
documents.

Quick Create adds all the documents
within a folder to your Overview.
Rfter you click continue, select any
document in the folder of your choice.

Cancel Continue

Fig. 6.10 The Quick Create dialog box

Gather Documents...
The Gather Documents command moves all documents used in the
current presentation to the same folder on your disk. To gather
documents the Overview document must be saved. The documents
gather in the same folder as the Overview document. Gathering
documents in one folder makes it easy to copy all of your
presentation at once, rather than search for scattered files. The
documents must all be on the same disk; you can't gather documents
from different disks.
I *  Tips & Hints I f  your Overview document includes another
Overview document, Gather Documents does not move it (or its
associated documents). You must move an Overview document
manually.
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Control
14 Rewind K R
41 Back Step N D
■  Stop
I I  Step X F
▶ Play M R

Sound Is On
Preferences...

Window
Stage 3 € 1
Panel 3 € 2
Oueruiew : : 3

The Control Menu
The Control menu contains commands that control the way a
presentation plays. The first five commands that appear in this
menu also appear in the Panel as buttons.

Rewind
Rewind returns to the beginning of the presentation.

Back Step
Back Step steps the presentation backward one column.

Stop
Stop halts the presentation.

Step
Step advances the presentation to the next column.

Play
Play starts the presentation.
If you press the Shift key when you choose Play, the Overview
window and Panel close and the presentation begins. The Stage
obscures the menu bar.

Sound Is On/Sound Is Off
This command toggles the sound on and off.

Preferences...
The Preferences command displays a dialog box that provides
options to set the size and location of the Stage, to set the Sounds file
name, and to set many other options. For complete information
about Preferences, see Chapter 6: Studio Reference in the MacroMind
Director Studio Manual.

The Window Menu
The Window menu gives you access to the three Overview windows:
Stage, Panel, and Overview. A  check mark appears next to the menu
command when that window is open. The active window is
indicated when the window's name is underlined.
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The Stage window
The Stage is the window in which the Overview presentation
appears. To get a full, uncluttered view of the presentation, choose
the Stage command from the Window menu. I t  clears the screen of
all the other windows and the menu bar. Choosing the Stage
command again returns all previously displayed windows to view.
The menu bar is active even when it is invisible. You can move the
pointer to the top of the screen, press the mouse button, and the
menus still function.

Fl
11
R E W

11
B A C K

■
S TO F

I I
S T E P

▶
P L AY

The boundaries of the Stage window usually coincide with the edges
of your monitor. For more information about setting the size of the
Stage, see Preferences in The Control Menu, Chapter 6: Studio Reference
of the MacroMind Director Studio Manual.
Graphics and movies can be selected and moved on the Stage. Click
a graphic to select it, then drag it to move it. Click any part of the
movie to select it, then drag to move the entire movie on the Stage.

The Panel window
The Panel has six buttons. Clicking the Panel buttons has the same
effect as choosing the commands in the Control menu.

Fig. 6.11 The Panel
Rewind winds the presentation back to the start. I f  the presentation
was running, it also stops.
Back steps the presentation backward one column.
Stop halts the presentation.
Step advances the presentation to the next column.
Shift-Step replays the current column.
Play starts the presentation.
Shift-Play brings the Stage window to the front, hiding the other
windows and the menu bar, and starts the presentation.
Loop causes the presentation to repeat continuously. When the
presentation reaches the end, it starts again with column 1. Loop is

00UOJeled Ill cr,

Chapter 6: Overview Reference 1 4 1



turned on when the button is selected. Clicking the Loop button
toggles Loop on and off.
You can move the Panel around on the Stage by dragging it. Just
place the pointer on the title bar, or anywhere on the Panel that isn't
a button, and drag. To close or open the Panel, choose Panel from
the Window menu. You can also use the close box to close the Panel.

 U n t i t l e d  Overview e l
0 - - 0 . 0 .,m_ -,..., 0 .

Q

0

I R 5
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The Overview window
The Overview window displays all the documents and effects used
to create an Overview presentation (or document). The icon bar at
the top of the window shows the icons that represent the kinds of
documents and effects you can use in a presentation.

Fig. 6.12 The Overview window

The first five icons from left to right in the icon bar represent the
types of documents you can display in Overview. When you drag
an icon from the icon bar and place it in the Overview working area
a directory dialog box appears. I t  displays a list of documents
available for that type of document. For example, if you dragged a
MacPaint icon from the icon bar, you would only see MacPaint
documents. When you select a document and click Open, its name
appears below the icon in the working area and the document is
assigned to that position in the presentation.
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A sixth Overview document icon at the end of the icon bar
represents complete Overview documents that you can add to your
presentation. A n  Overview presentation or document is actually
a collection of documents and effects represented by icons in the
Overview window.
Table 6.1 Document file types and applications that create them

Document file type: C a n  be created by:

MacPaint

PICT

Glue

MacPaint
FullPaint®
SuperPaint

MacDraw, MacDraw II
MacDraft®
SuperPaint
Adobe Illustrator
Aldus FreeHand-
PixelPaint-
Adobe PhotoShop
Studio /8 or 32
Dreams
Other digitizers and 3D programs

Glue
SuperGlue
AppleLink Linksaver
Any application that can print can be
used to create a Glue document

MacroMind Accelerator M a c r o M i n d  Accelerator

Overview M a c r o M i n d  Director

Overview effects
Three icons in the icon bar represent the effects you can use in
Overview presentations.
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Sales Meeting Oueruiew

Timer

Transition
Sound

A %

1) a 0
O3430
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I < O M . .  0 0 . 2 0 . 0 0 t ..41I
Company Logo

: :::(1101:
Fiscal Year

9
Intro1

5  M   5

Market Share Titles F o r e c a s t

e P .

Transition 1

GIF

Fig. 6.13 A presentation of movies and slides with a transition, timer,
and sound

The sound icon represents sounds added to your Overview
document. For sounds to be heard, you must drag a sound icon to
the Overview window, choose a sound from the Sound menu while
the sound icon is highlighted, set a timer for at least the length of the
sound, and make sure that the Sound Is On command is checked in
the Control menu.
The timer icon is used to assign the length of time, in seconds, that a
column will be displayed on the Stage. Set the timer by typing the
number of seconds below the timer icon. A l l  slides to the right of the
timer's column will also appear for that length of time, until a new
timer is set.
The transition icon controls the way one slide changes into the next.
The main categories of transition are wipe, push, reveal, cover, strip,
and dissolve. When you drag a transition icon into the working area
a dialog box appears showing all of the transition choices.

144 T h e  Window Menu



Set Transition...

"III

DIM

I I

Strips on right, build down
Strips on right, build up
Strips on top, build left
Strips on top, build right
Venetian Blinds
Vertical Blinds
Wipe down
Wipe left
Wipe r ight
Wipe up

I =  Zoom close
F-1 Zoom open

Duration:

in 1 / 4  seconds

Chunk Size:
<3
smooth rough

C) Stage area
0  1: hanging i i rea

Cancel

( Set Transition

Fig. 6.14 The Overview Set Transition dialog box

Select the transition you want from the list. For more information
about using transitions, timers, and sounds, see Chapter 5: Using
Overview.
Duration determines how long the transition takes.
Chunk Size controls the number of pixels that are changed in each
movement of the transition.
To stop a transition during playback and advance the playback head
to the next frame, hold down the Command key and press the
Period key.

Auto Animate
Use Auto Animate to add titles, charts, and text effects to your
presentation. Use Auto Animate in the Overview window for
constructing quick text and chart effects.
The Auto Animate effects are basic animation. I f  you want more
elaborate effects you must use Studio. You can use Auto Animate in
Studio to provide the basis for a more complex effect. When you use
Auto Animate in Studio, the parts of the effect become castmembers
and a complete Score is generated. You can then proceed to modify
the effect using the powerful Studio's tools.
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For example, the effects cannot be combined in the Overview portion
of MacroMind Director. Titles that zoom in cannot then shimmer
and disappear upwards. However, if you create a Zoom Text effect
using Auto Animate in the Studio portion of MacroMind Director,
you can then easily modify the result by adding castmembers,
creating additional animation effects, and making changes to the
Score.

Working With Auto Animate
To begin working with Auto Animate, drag the Auto Animate icon
into the working area of the Overview window and then choose the
Auto Animate effect you want.

Ruto Rnimate...

C) Bullet Chart

l i 1 i 1 0  Bar Chart

j ' A O  Zoom Test

4-ABC 0  Banner

= =  0  Credits

- A -  0  Tel-it Effects

Cancel OK

Fig. 6.15 The Auto Animate dialog box

When you click OK, the dialog box for your choice appears. In the
dialog box you type the text you want, set the font, size, and style,
and make any adjustments to the speed and other controls. You then
preview the result to see the effect, set the start location if necessary,
and return to the dialog box for any remaining adjustments.
When your Auto Animate effect is satisfactory, you return to the
Overview window. The Auto Animate effect is displayed as an icon
in a slide in the Overview window's working area.
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You can return to the effect at any time to make additional changes
by choosing Get Info from the Edit menu, or by double-clicking the
icon.
The following sections describe each Auto Animate effect in detail.

Bullet Chart
Bullet Chart allows you to create an animated bulleted list.

Sales Meeting Agenda

•  Quarterly Results

•  New Products

•  Sales Awards

.1111111 — — • Strategic Directions

Fig. 6.16 A typical bulleted list

Typically, the title of the bulleted list appears first and is stationary;
the items and their bullets travel into place through animation. On
this basic theme, MacroMind Director allows you to play many
variations.
You can determine the direction from which the bulleted items
come. You can choose from several different bullets. You can
animate the title as well as the bullets. You can have no animation at
all, simply presenting a bulleted list. Or you can dispense with
bullets altogether, presenting only a title and list.
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Bullet Chart
Title:

Bullets:

a tle

First Bullet Teut
Second Bullet Teut

Abc
Bullet Type:

Motion:
Vertical
Spacing:  s m a l l  P 1 0 1 7 7 1 - q  large

❑  Animate Title
❑  Mouseclick Advances

( Title Text Style...

•  Dot
from Right

Preview...

Abc 'Bullet Teta Style...

Speed: slow
Initial Delay: short
Bullet Delay: short

Ending Delay: short

Cancel

<31114
<3

<3

20 Eii

0 kiimelu

<310

t O K

fast
long

long

long

Fig. 6.17 The Bullet Chart dialog box

You can enter up to 255 characters in the Title text area and in each
Bullet text area. MacroMind Director assigns the text you type for
the Title as the name of the auto animate icon in the Overview
window. I f  you enter a name that is longer than 30 characters,
Director only displays the first 30 characters.
Title Text Style and Bullet Text Style gives you complete control over
the text font, size, style, transparency, and color of the title text and
the bullet text. For descriptions of the text settings controls, see Auto
Animate text at the end of this section.
Bullet type provides choices for different types of bullets. Choices
include a Dot, a Square, a Hand, a Check, and an Arrow. Three
choices provide for animated bullets, that move into place. These are
the Flying Hand, the Animated Check, and the Flying arrow. You
can also choose to have no bullets, or to have no bullets and the text
and title centered.
Motion provides choices for how the bulleted items appear. The
choices include from Right, Bottom, Left, Top, Upper Right, Lower
Right, and so on. Choices also include Stationary (no movement),
Wipe from Right, Wipe from Left, and Dissolve.
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Vertical Spacing controls the amount of space between items on the
chart.
Speed controls how fast the animation occurs, in this case how
quickly the bulleted items move into place.
Initial Delay controls the length of time before the effect starts.
Bullet Delay controls the length of the pause between lines of text
moving into place. A  short Bullet delay means that there is a very
short pause between one line moving into place and the beginning of
the next line's movement.
Ending Delay controls how long the completed chart is displayed.
Animate Title causes the title text to also move into place. An
animated title obeys the Motion, Speed, and Bullet delay settings.
Mouseclick Advances overrides the Bullet delay setting and causes
the bulleted items to move into place only when you click.
Preview displays the bullet chart as it will appear in the presentation,
including any background images. Use the Preview screen to adjust
the location of the bullet chart. To set the location, you click with the
mouse. Setting the starting location sets the position of the upper left
corner of the title.

Bar Chart
Bar Chart allows you to create an animated bar chart.
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Title
Range maximum

Vertical label

Range minimum
Bar label

T
h
0

S
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20

1
Ci 8

Market Share

1988 1 9 8 9

Fig. 6.18 A typical bar chart

The title and labels of the bar chart appear first and are stationary;
the bars grow into place through animation. MacroMind Director
allows you to control the scale of the chart, the height of the bars, the
style of the bars, the speed of their growth, and the ending delay.
You can use up to six bars. The width of the bars is set automatically
depending on the number of bars you are using. The actual length
of the horizontal and vertical axes does not change, just the values on
the scale. The height of the bars is proportional to the scale you set.
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Bar Chart

Title: Sales Results ( T i t l e  Test Style...) A b c
Vertical
Thousands ( L a b e l  Test Style... A b c
Bar V a l u e :

Bar 1 East 5 Bar Style: S o l i d

Bar 2 Midwest 10 Range: m i n  M a l i
Bar 3 West 15 0 2 0

Bar 4 0 fastSpeed:  s low 2 0 _
Bar 5 0 Initial Delay: short o  0 long

Bar 6 0 Ending Delay: short  0 long

( Preview... Cancel ( O K

Fig. 6.19 The Bar Chart dialog box

You can enter up to 255 characters in the Title text area and in the
Vertical label text area. MacroMind Director assigns the text you
type for the Title as the name of the auto animate icon in the
Overview window. I f  you enter a name that is longer than 30
characters, Director only displays the first 30 characters.
Title Text Style and Label Text Style give you complete control over the
text font, size, style, transparency, and color of the title text and the
label text. For descriptions of the text settings controls, see Auto
Animate text at the end of this section.
Bar is where you enter a label that appears below each bar. You can
enter up to 31 characters for each label. I f  the labels are so long as to
overlap, you can either use shorter labels or adjust the font, size, and
style of the labels.
Value settings determine the height of each bar, in relation to the
scale of the vertical axis. You can enter any positive values between
0 and 32,000.
Bar style provides several choices for different types of bars. Choices
include dollars, solid black, and gray.
Range settings determine the scale shown on the bar chart. The scale
affects the height of the bars, which grow to a height proportional to
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the scale. You can set the maximum and minimum to any positive
values between 0 and 32,000.
Speed controls how fast the animation occurs, in this case how
quickly the bars grow into place.
Initial Delay controls the length of time before the effect starts.
Ending Delay controls how long the completed bar chart is displayed.
Preview displays the bar chart as it will appear in the presentation,
including any background images. Use the Preview screen to adjust
the location of the bar chart. To set the location, you click with the
mouse. Setting the starting location sets the position of the upper left
corner of the chart. The upper left corner is determined by the top of
the title text and the left edge of the vertical label text.

Zoom Text
Zoom Text allows you to create an animated zoom effect. "Zoom"
comes from the motion picture camera technique of changing
smoothly from a long shot to a closeup (zoom in), or from a closeup
to a long shot (zoom out).

Starts small N E I l i  s A l .  M E E M I G

Grows 1991 SALES MEETITIG
Becomesfull size -1991 SALES MEETITIG

Fig. 6.20 A typical Zoom Text effect

You can choose whether the text you enter grows from nothing to
full size (zoom in), from full size to nothing (zoom out), or first
zooms in then zooms out. The text grows and diminishes through
animation. MacroMind Director allows you to control the number of
times the effect is repeated, the speed at which the effect occurs, the
length of an initial delay, and how long the full-size text remains on
the screen.
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 Z O O M  TOO

Repetitions: Speed: slow 20 fast

®  once i  C >  many Initial Delay: short 0 long

0  Continuous, Use Timer Full-S ize  Duration: short <3 0 c> long

Zoom Teat

Abc Text Style... Zoom Type: Zoom in

Preview... ( C a n c e l OK

Fig. 6.21 T h e  Zoom Text d ia log box

You can enter up to 75 characters in the text area. MacroMind
Director assigns the text you type in the text area as the name of the
auto animate icon in the Overview window. I f  you enter a name that
is longer than 30 characters, Director only displays the first 30
characters.
Text Style gives you complete control over the text font, size, style,
transparency, and color of the text. For descriptions of the text
settings controls, see Auto Animate text at the end of this section.
Zoom Type determines whether the text zooms in, zooms out, or first
zooms in and then zooms out.
Repetitions controls how many times the effect is repeated. I f  you
select "Continuous, Use Timer" the number of repetitions is
determined by the timer in effect when the slide is played.
"Continuous, Use Timer" is not available when this effect is created
using Auto Animate in Studio.
Speed controls how fast the animation occurs, in this case how
quickly the text grows from nothing into full size or diminishes from
full size to nothing.
Initial Delay controls the length of time before the effect starts.
Full-Size Duration controls how long the full-size text is displayed.
Note that the text is full-sized at the beginning of a zoom out effect,
in the middle of a zoom in and out effect, and at the end of a zoom in
effect. 00UalGjed . o.
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Preview displays the zoom as it will appear in the presentation,
including any background images. Use the Preview screen to adjust
the location of the text. To set the location, you click with the mouse.
Setting the starting location sets the position of the middle of the
text.

Banner
Banner allows you to create an animated message that scrolls across
the screen.

- 4 1111 ( —
= - = -  _ - =  =

Fig. 6.22 A typical Banner effect

You can control the number of times the banner is displayed, the
length of an initial delay, and the speed at which the effect occurs.
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Banner

Canner Text

Abc Text Style...
Speed: slow

Initial Delay: short
E d  20

n i E>1
fast

long

Repetitions 0  0 . many 0  Continuous, Use Timer

Preview... ICance l OK

Fig. 6.23 The Banner dialog box

You can enter up to 255 characters in the text area. MacroMind
Director assigns the text you type in the text area as the name of the
auto animate icon in the Overview window. I f  you enter a name that
is longer than 30 characters, Director only displays the first 30
characters.
Text Style gives you complete control over the text font, size, style,
transparency, and color of the banner text. For descriptions of the
text settings controls, see Auto Animate text at the end of this section.
Speed controls how fast the animation occurs, in this case how
quickly the text moves across the screen.
Initial Delay controls the length of time before the effect starts.
Repetitions controls how many times the effect is repeated. I f  you
select "Continuous, Use Timer" the number of repetitions is
determined by the timer in effect when the slide is played.
"Continuous, Use Timer" is not available when this effect is created
using Auto Animate in Studio.
Preview displays the banner as it will appear in the presentation,
including any background images. Use the Preview screen to adjust
the location of the text. To set the location, you click with the mouse.
Setting the starting location sets the position of the top of the text.
Note that the starting location affects only the vertical dimension;
wherever the starting location, the banner text travels from off the
right side of the screen to off the left side of the screen.

eOLIeJejed II Ck
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Credits
Credits allows you to create an animated credit list that scrolls up the
screen. "Credits" comes from the motion picture practice of giving
credit to everyone who worked on a movie in a scrolling list at the
end.

Animation: Grafica Multimedia, Inc.
Video Production: Lights, Inc.

Script Writers: G. & M. McCrath
Page Layout: RutherFord Graphix, Inc.

Illustrations: Maruther Company

Fig. 6.24 A typical Credit list
You can control the number of times the credit list is repeated, the
speed at which the effect occurs, the length of an initial delay, and
the justification of the text (left, right, or center).
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Credits

C r e d i t s
t e a t

Q

Abc
Repetitions:
0  once

Teat Style...

many
Justification:

0  Continuous, Use Timer

Initial Delay:

Center

Preview...

Speed:

( Cancel

<3
short

o
long

NMECINES
slow fast

OK

Fig. 6.25 The Credits dialog box

Enter text in the text area, using the Return key to end a line of text
and start a new line. There is no limit to the width of an individual
line, except the practical limit of the screen width. Text that is too
long to fit on one line of this dialog box wraps to the next line. Text
appears in the preview as it will in the final slide.
You can enter up to 255 characters in the credit list. MacroMind
Director assigns the text you type for the first line of the credits as
the name of the auto animate icon in the Overview window.
Text Style gives you complete control over the text font, size, style,
transparency, and color of the credit text. For descriptions of the text
settings controls, see Auto Animate text at the end of this section.
Initial Delay controls the length of time before the effect starts.
Repetitions controls how many times the effect is repeated. I f  you
select "Continuous, Use Timer" the number of repetitions is
determined by the timer in effect when the slide is played.
"Continuous, Use Timer" is not available when this effect is created
using Auto Animate in Studio.
Justification controls whether the credit text is justified flush left,
flush right, or is centered.

80Ualejed II on
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Speed controls how fast the animation occurs, in this case how
quickly the text moves up the screen.
Preview displays the credit list as it will appear in the presentation,
including any background images. Use the Preview screen to adjust
the location of the text. To set the location, you click with the mouse.
Setting the starting location sets the position of the center of the text.
Note that the starting location affects only the horizontal dimension;
wherever the starting location, the credit list travels from below the
bottom of the screen to off the top of the screen.

Text Effects
Text Effects allows you to create one of three animated effects on
text. The effects include Sparkle, in which an animated highlight
appears and disappears; Letter slide, in which the text is built up
letter by letter sliding into place; and Typewriter, in which the letters
appear one at a time, as if typed.

A b c  ( T e x t  Style... Speed: slow
Initial Delay: short

agNIMIBE fast

long
Effect:  Sparkle Ending Delay: short igingie.)1long

Sparkle flashes
across letters /1991 Sales Meeting

Fig. 6.26 A typical Sparkle effect

You can control the number of times the effect is repeated, the speed
at which the effect occurs, the length of an initial delay, and the
duration of the pause after the end of the effect.

Tenet Effects

erct Effects

Repetitions: Q  once I 0 1  many Q  Continuous, Use Timer

Preview... Cancel OK

Fig. 6.27 The Text Effects dialog box

You can enter up to 255 characters in the text area. MacroMind
Director assigns the text you type in the text area as the name of the
auto animate icon in the Overview window. I f  you enter a name that
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is longer than 30 characters, Director only displays the first 30
characters.
Text Style gives you complete control over the text font, size, style,
transparency, and color of the text. For descriptions of the text
settings controls, see Auto Animate text at the end of this section.
Effect provides three choices for the effect you want. Choices include
Sparkle, Letter Slide, and Typewriter.
Speed controls how fast the animation occurs, in this case how
quickly the text moves up the screen.
Initial Delay controls the length of time before the effect starts.
Ending Delay controls how long the text is displayed after the effect
is finished.
Repetitions controls how many times the effect is repeated. I f  you
select "Continuous, Use Timer" the number of repetitions is
determined by the timer in effect when the slide is played.
"Continuous, Use Timer" is not available when this effect is created
using Auto Animate in Studio.
Preview displays the text effect as it will appear in the presentation,
including any background images. Use the Preview screen to adjust
the location of the text. To set the location, you click with the mouse.
Setting the starting location sets the position of the center of the text.

Auto Animate text
You can set the font, size, and style of any text you use in any Auto
Animate feature. MacroMind Director provides pop-up menus for
the Font, Size, and Style choices.

93UGJ8J8d . o,
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TeHt Style

Abc
Font

Size

Style

Colorilk
New York

24 point

Bold

❑  Transparent TeHt

Cancel ( O K   )

Foreground color
Background color

Pop-up menus

Fig. 6.28 The Text Style dialog box

Fonts sizes installed in your System appear outlined in the Size
pop-up menu. The Macintosh operating system creates
approximated versions of font sizes that are not installed in your
System.
In addition, you can create transparent text and set colors for the text
and background. Transparent text allows any background image to
show through the spaces between letters in the text. You can
position the text, for example, so that a face appears in the middle of
the letter 0. I f  "Transparent Text" is not selected, the text appears on
a white rectangle that obscures anything behind it.
Position the pointer on the foreground or background color chip and
press the mouse button to display the current palette. Choose the
color you want from the palette. The foreground color sets the color
of the text itself. The background color sets the color of the text
rectangle on which the text is displayed.
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Sound
Ens'
l i l l i

▶
▶

1 -  Basics ▶
2 -  Explosions ▶
3 -  Weapons ▶
4 - Instruments ▶
5 - Nature ▶
6 -  Space ▶
7 - Old Music ▶
8 -  New Music ▶
9 -  Business ▶
F -  Macintalk ▶

The Sound Menu
The Overview Sound menu shows dozens of sounds you can add to
your presentation.
For the Sound menu to appear, you must have a file called Sounds in
the same folder as MacroMind Director, the System file, or the
Overview document you are creating. You can also associate a
sounds file with an Overview document by using the Preferences
command on the Control menu.
To assign a sound to a particular column in your presentation, a
sound icon must be in that column of icons in the Overview
window, and the icon must be selected before you choose the sound
from the Sound menu.
When you pull down the Sound menu and highlight a category, a
submenu appears with a list of sounds in that category. To choose a
sound, drag to the sound's name and release the mouse button.
Don't forget to set a timer for at least the length of the sound, and
make sure the Sound Is On command is checked in the Control
menu.
The Sounds file that comes with MacroMind Director has several
categories of sounds. They are:
♦ M u s i c  (Old Music, New Music, Instruments)
♦ Effects (Basic, Explosions, Weapons, Nature, Space)
•  Presentations (Business)
♦ Synthesized speech (Macintalk)
You can add to the range of sounds in your presentation by
digitizing your own sounds with MacRecorder from Farallon
Computing. You can also add sounds to the Sound menu using the
Sounds Utility that comes with Director. For complete information,
see Chapter 6: Studio Reference in the MacroMind Director Studio
Manual.

00thaleied U o•
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Appendix A: Finding Missing Documents

This appendix describes how to find documents that are missing
when the Overview presentation can't find them.
If any documents are missing when you play a presentation,
MacroMind Director tells you that it "Can't Find the File" and gives
the name of the file that is missing.

Can't Find the File "US Map 1"
From the Directory

"Tutorials D. Sounds:Oueruiew Tutorial:"
Do You Want To Look For It?

Look For I t

( Cancel and Stop (Skip and Continue:

Fig. A.1 The "Can't Find the File" dialog box

MacroMind Director may not be able to find a document because it
has been moved to another folder, or the folder or file has been
renamed.
If MacroMind Director cannot find a file,
1. C l i c k  the "Look For It" button.
The directory dialog box appears. Look for the file on the disk.
Once you've found the file, go to the next step.
2. S e l e c t  the missing file and click Open.
Another dialog box appears.

x!pueddy U >
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For Other Icons That Currently Refer to the Directory
"Tutorials D Sounds:Overview Tutorial:"

Do You Want to Change Them To Refer To the Directory
"DIRECTOR 3.0:"?

I No Yes )
Fig. A.2 The 'Change other icons" dialog box

This dialog box asks if you want to change the location reference for
other icons in this Overview presentation. You have just located the
first missing file, and MacroMind Director assumes that other files
will have been moved to the same new location.
If you click Yes, MacroMind Director automatically makes the same
change to the other documents in the Overview document that need
the change. This change does not affect documents in any other
location. I f  you click No, MacroMind Director continues to look for
subsequent documents in their original location. I f  it doesn't find
them, it will go through this process again.
Most of the time you should click Yes in this dialog box.
3. C l i c k  Yes or No.
MacroMind Director continues playing the presentation.
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Appendix B: Command Keys and Shortcuts

Overview Command
keys

Table B.1 lists the Macintosh Command key equivalents for
Overview menu commands. Commands that are not listed don't
have a Command-key equivalent.

Table B.1 Overview's Macintosh Command key equivalents

Menu Command S t a n d a r d  Macintosh
FILE

New C o m m a n d -N
Open C o m m a n d - 0
Save C o m m a n d -S
Launch Editor C o m m a n d -L
Quit C o m m a n d -Q

EDIT
Undo C o m m a n d -Z
Cut C o m m a n d -X
Copy C o m m a n d -C
Paste C o m m a n d -V
Get Info C o m m a n d -I

CONTROL
Rewind C o m m a n d -R
Back Step C o m m a n d -D
Stop C o m m a n d -W
Step C o m m a n d -F
Play C o m m a n d -A

WINDOW
Stage C o m m a n d -1
Panel C o m m a n d -2
Overview C o m m a n d -3

xpueddv co
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Overview shortcuts
Table B.2 lists keyboard shortcuts to perform many of the Overview
operations.

Table B.2 Overview's shortcuts

General

With numeric keypad

Overview window

Stage window

Panel window

Save dialog box

To do this: Type this:

Toggle sound on and off
Toggle all white stage
on and off

Rewind
Back
Stop
Step
Play
Clear the Stage and play
Toggle sound on and off
Toggle Loop on and off
Replay current column
Toggle all black stage
on and off
Toggle play/stop
Toggle invert stage on and off
Toggle cursor display
on and off

Select entire column
Duplicate icon
Extend selection
Get Info on icon
Launch Editor on icon

Step
Replay current slide
Cancel transition
and advance to next frame

Clear the Stage and play
Replay current slide

Save
Don't Save
Cancel

Command- -  (tilde)
, (comma)

0
1,4
2, 5, . (period)
3, 6
Enter
Shift-Enter
7
8
9
- (minus)

+ (plus)
/ (slash)
= (equals)

Command-click Icon
Option-drag icon
Shift-click icon
Double-click Icon
Command-double-
click icon

Click
Shift-click
Command-Period

Shift-click Play button
Shift-click Step button

Y or S
N or D
C
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159-160
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Bar Graph

creating with Auto Animate 29
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Animate title 23-24
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Bullet type 24-25, 148
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changing the text font and size
160
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creating with Auto Animate 19
Ending delay 37, 149
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Motion 24, 148
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C
channel indicator 80
Clear Overview command 134
Clip animation 46, 68

adding to a slide 67
changing position 69
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Color Movie Show 15
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Control menu 12, 140
Controlling the Presentation 11-14
Copy Overview command 134
Creating a presentation 46
Credits 41, 156
Credits dialog box 157
Cut Overview command 134

D
delaying clip animation 70
Director movie 46, 48

controlling length 103
controlling sound 105
creating an overlay 78
delaying 104
holding first frame 105
holding last frame 105
repeating 72, 104
repositioning 54, 102

Set start location with mouse 55
Start after 56

Director movie icon
using 49

Director movie overlay
creating 109
using to add text 110

Director movies
controlling sound 137
Get Info 134
holding first or last frame 105, 137
Position options 137
Timing options 136

document types 95
Duplicating an icon 53, 70
duration

changing for a slide 52
of a slide 53

E
Edit menu 133
Editing a presentation 51, 65

F
File menu 129
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frame 54

G
Gather Documents command 99,139
Get Info

Accelerator 137
Director movies 136
Glue 135
MacPaint 34-35, 135
opening 102
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using 34-35, 54-56, 69, 70, 100-108

Get Info command 134
Glue documents

Get Info 135
repositioning 101

Guided Tour 9

H
Help 4
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Help window 128
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M
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opening 44
opening Get Info 100
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presentations 28, 45
Printing 39-41, 111
rearranging 97
repositioning 100
rewinding 92
selecting 96
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untitled 46

Overview effects 115,143
sound 117, 118, 144
timers 115-117, 144
transitions 118-120,144
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Overview file 39
Overview icons

using 95
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Overview Tutorial 43-60

Advanced 61-88
Overview window 10, 45, 90,142

printing contents 111
using cut, copy, paste 98
working with 18

P
Page Layout dialog box 112,133
Page Setup command 131
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Panel window 11, 12, 141

Back 12, 141
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Loop 141
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Play 141
Rewind 141
Shift-Play 141
Shift-Step 141
Step 141
Stop 141

Paste Overview 134
PICT documents

Get Info 135
repositioning 100

Play command 140
playback head 64-65
Playing a presentation 28, 33, 45, 51
Playing an Overview document 91
Playing MacroMind Director
presentations 9
positioning clip animation 68
Preferences 109
Preferences command 140
presentations

controlling 11
creating 46
playing 9, 28, 33, 45, 51

Preview 23, 31
Print command 132
Print Options dialog box 112, 132
Printing

Overview documents 39,111
storyboards 113-114

Quick Create command 98, 139
Quit command 133
R
Rearranging documents 97
Repositioning an image 54-44
Return to Overview command 131
Revert command 131
Rewind 34
Rewind command 140
Rewinding an Overview document 92
S
Save As command 130
Save command 130
Saving your presentation 39
Select All command 134
Selecting documents in the Overview
window 96
Set Transition dialog box 57, 119, 145
shimmer

adding 71
shortcuts

for controlling 13
list 165

slide 27, 47, 93
slide show 27, 60
sound icon 144
Sound Is On/Sound Is Off command
140
Sound menu 161
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Sounds 73-76
adding 73, 117418
changing 118
controlling 118
with timers 76

Sounds file 73, 161
speaker volume

changing 63
Stage window 12, 141

boundaries 141
start location

changing bullet chart 36
setting for Zoom Text 81

Starting MacroMind Director 8
Step command 140
Stepping through an Overview
document 92
Stop command 140
Stopping an Overview document 91
storyboards

printing 113-114
Studio

Cast window 82
castmember 82
introduction 2
Paint window 83
screen 79
windows 78

Studio Panel
background control 79
channel indicator 80
frame counter 80
sound control 79
tempo 79

T
Text Effects 41, 158
Text Effects dialog box 158
timer icon 149
timers 45

adding 115
changing 116
setting multiple 116
using 52
using with sound 76

To Studio command 129
transition icon 144
transitions 45

adding 118
changing 120
Chunk Size 57, 120
controlling 122

Duration 57
setting 118 - 120
speed 120
types 119
using 56-58, 121

U
Undo command 133

W
Window menu 12,140

Z
Zoom Text 41, 152
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Zoom Text Effect 80
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